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WELCOME
Welcome to the blackbox user manual. Thanks for taking the team to read this. If you
want to get a quick overview of the basic features of blackbox, please check out the Quick
Start Guide. You can find it in the box with your blackbox, or on the blackbox support
page at:
https://1010music.com/blackboxdocs
If you are ready to get more detail about a specific feature or learn more of the
capabilities of this portable sampling studio, then this is the document for you. We will
get into more detail about setup options, explain the features in each of the screens, get
your MIDI connections working, move files around and cover some tips to get the most
out of your blackbox.
If you still have questions after reading this manual, join our forum at
forum.1010music.com. You can specifically get blackbox support at:
https://forum.1010music.com/forum/products/blackbox/support-blackbox
Our support team and other users are out there to help you and to exchange ideas about
how to get the most out of blackbox. Registered forum users can also get the latest
firmware with new features and bug fixes in the downloads section of the forum.
Registration is free, but you will need to provide an email address.
Before you get started, you may want to check for firmware updates for your blackbox.
Learn how to do that in Update Firmware, Audio Files and Presets section near the end of
this document. This document covers version 1.7 firmware.

Pads

Keys

Sequences

Song Sections

FX

Mixer
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SET UP BLACKBOX
You have probably already plugged in your blackbox and started to play with it. Let’s
make sure you have everything set up properly so you can follow along with the manual.
Blackbox stores all of the samples and presets on the microSD card. Before you can use
the blackbox, you will need to insert the microSD card, connect to power and connect to
one or more outputs. You can then also connect an audio input for recording.

MicroSD Card for Storage
Take the microSD card out of it’s plastic case, A in the
figure to the right. Insert the microSD card, with the text
facing up and the notched edge to the right, into the
MICRO SD slot, S, on the front panel. The card reader is
spring loaded. Push the card in to remove it when
needed later. Leave it in for now.

S

Power

MicroSD Slot

Blackbox needs to be connected to a 2 amp power
source. You can plug it into a standard power outlet or a
USB power supply. Either way, you will insert the square
end of the USB Power cord, B, into the POWER
connection on the back panel. The connection is snug to
ensure that the device stays plugged in during use.

Standard Power Outlet:
If you are plugging directly into a standard power outlet,
slide the appropriate two or three prong connector, E,
onto the USB power supply, D. Then connect the flatter
end of the USB power cord, B, into the USB connection
on the power supply. Bluebox will turn on as soon as the
power is connected.

USB Power Outlet:

A

B

C

D

What Comes in the Box

If you are using your own USB power supply, plug the
flatter end of the USB power cord into a 2 amp USB
power supply, such as a USB outlet or a USB battery
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NOTE:
► Not all USB power supplies are created equal. Make sure your power
supply can provide 2 amps of power. The USB power supply included
with blackbox will do this.
► Not all USB Type B cables are the same. Some are made only for data,
while others are designed to carry power. Blackbox comes with a USB
Type B power cable. If you want to replace it with a longer cable, be
sure it is rated to carry power.
► You can take the microSD card out and reinsert while blackbox is
powered up.
► When you plug blackbox into a USB power bank, keep in mind that
these power banks do not send information to blackbox about how
much power is remaining. There may be a low power indicator light on
the power bank itself. Blackbox will not give you a warning when power
is low, so be sure to save your presets before the power bank runs out.
► Some batteries may not be sufficient to support a USB MIDI device in
addition to blackbox. See Powering MIDI Devices below for more
information.

Output Connections
Connect speakers or headphones to the audio outputs
on the back panel. To start, we recommend connecting
external speakers or headphones to the PHONES jack,
since all outputs are routed to the PHONES jack and you
can control volume from blackbox. All of the audio jacks
are stereo 3.5mm connectors. This makes for a total of 6
audio outputs (3 Audio Out jacks x2), stereo headphones,
and a stereo input. The audio output will be at Eurorack
levels which is +/- 5 volts. This is louder than a consumer
electronics line level, so you may need a mixer to
connect with consumer electronics gear.

Copyright 1010music LLC 2021
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Control the Volume
If you are using the PHONES jack, you can control the volume of the
output:
1.

Press the TOOLS button.

2.

Turn the knob next to the Headphone parameter at the top
right.

Tools Screen

Test Your Setup
Let’s make sure you are getting some sound out of your blackbox
before we continue.
1.

Press the PADS button. You will see a grid of samples that
have been assigned to the current preset.

2.

Touch one of the pads on the touchscreen to trigger
playback of the pad. You should hear the sample playing
out through the connected audio output.

Pads Screen

If you don’t hear anything, try a different pad. Some pads may be
assigned to different outputs, but all pads will play out through the
PHONES output. If you get a white bar across the bottom of the pad,
push the PLAY button to start the clock and enable playback of the
Clip pad.

Connect an Audio Input for Sampling
Blackbox assumes Eurorack level audio is coming in to the AUDIO IN jack at +/-5V. If you
are using a line level signal of +/- 1V, you may need to adjust the input gain on the
recording screen. You could also use a mixer or preamp with your microphone or other
input to adjust the level of the incoming signal. See the section Record a New Wave File
for more information about working with inputs.
Your blackbox should be setup and working now. Next we will cover the basic controls
and workflow of blackbox.
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OVERVIEW
Blackbox is a compact sampling studio.
With blackbox, you can record and play
samples, sequence those samples into
patterns and riffs, and then record those
sequences into sections, which together can
form a song. Use blackbox to record
complete compositions from the comfort of
your studio or, with the help of a USB power
block, from the seat of your train or the park
bench. You can also use blackbox to create
materials to play in the background while
you sing or perform with other instruments.
We can’t wait to see what you create with it!

blackbox

BACK

PADS

KEYS

SEQS

SONG

FX

REC

INFO

MIX

PSET

STOP

TOOLS

PLAY

Blackbox has a fairly simple set of input controls. You choose which functional area you
are controlling by pushing the white navigation buttons. You control playback and
recording of clips, sequences and songs using the black REC, STOP and PLAY buttons.
You select and trigger sound elements and configure parameters using the touch screen
and the knobs. The INFO button allows you to drill into an item selected on the screen to
edit more details. Push it again to access more detailed information about the item. The
BACK button takes you to the previous screen.

Navigation Highlights
To build your song with blackbox, start by working through the navigation buttons from
left to right. You can certainly jump around and do things in any order, but the general
flow is to start on the left and move to the right.
PADS Play, record, and organize a bank of samples. Blackbox comes with hundreds of
samples and allows you to record or transfer over your own WAV files.
KEYS Play samples chromatically. You can also connect a MIDI device to blackbox to
trigger pads.
SEQS Record sequences as you play pads or keys. Each sequence can record any one
or more of the pads. Toggle sequences on and off over time.
SONG Enable Song Mode to record Song Sections as you turn sequences on and off.
FX Apply effects to individual pads. Adjust the parameters for the delay and reverb
effects.
MIX Adjust the volume and pan of each pad.
PSET Save your work and start a new creation.
Copyright 1010music LLC 2021
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Pads Screen

Display Highlights
The black bar along the top of the screen displays the blackbox playback state and
recording context. The number pair on the left displays the overall playback time in
measures and beats. The text in the middle displays the recording context. In Song Mode,
this will display the name of the section that you are recording into. When not in Song
Mode, this displays the number of the sequence that will be recorded. You can toggle the
state of Song Mode by pushing the SONG button, then touching the on-screen Song
button. Song Mode is active when the on-screen button is blue. In the top right-hand
corner, a progress bar displays the current playback progress of the sequence or section
that has recording context.
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QUICK START
Blackbox comes with a number of presets on the included microSD card. Let’s explore
one to see how blackbox works. We will dive into more detail later. We will start by loading
a preset:
1.

Push the white PSET button to see the preset loader screen.

2.

Turn any knob to scroll through the list of presets until you have SL BASS MUSIC
KIT highlighted in blue.

3.

Touch the Load button at the top of the screen to load the preset and go to the
PADS screen. If this preset is already loaded, the Load button will be disabled.

Explore PADS
Touch the PADS button to go to the Pads screen with a grid of 16 WAV files. Touch a pad
to trigger it. Depending on how the pad is configured, the sample might play all the way
through each time you press it, it might play only while you are touching the pad, or it
might play until you touch it again. A blue progress bar appears at the bottom of the pad
while it is playing. You can trigger multiple sample pads at once.
The pink box indicates which pad is currently selected. Use the touch screen or a knob to
select a pad. Push INFO to cycle between the WAV screen and the parameters screens for
the selected pad. Touch the page names at the bottom of the parameters screen to
access additional parameter pages. Touch the name of the WAV file at the top of the
waveform screen to select a different WAV file for this pad. Touch the grid icon in the top
left corner to select a different pad to edit. The colored square in the grid indicates the
selected pad.
While on the Pads screen, turn the lower right knob to access the Clipboard menu, where
you can cut, copy, paste and clear pads. Turn the knob the other way to bring back the
Velocity slider.

Pads With Velocity Slider

Copyright 1010music LLC 2021
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Explore KEYS
Let’s find some new ways to play with our samples on the Keys
screen. To start, please select one of the pads labeled SY Chor and
push the KEYS button. Blackbox displays a keyboard on the screen.
Touch some of the keys on the keyboard to hear the selected pad
play pitch shifted by key. You can adjust which octave is playing by
touching the arrow buttons above the keyboard or by turning a
knob. The C keys are numbered so you can quickly identify which
octave will be playing.

Keys Screen

Push INFO to access the Grid Based keyboard. Use the two buttons
at the top right of the screen to select the Key and Scale that will be
used by the grid keyboard. Now you can play without worrying
about hitting an off-key note.
If you have a slicer pad selected when you are on the Keys screen,
the keys and grid squares will trigger different slices. The first slice
plays with C2. We will go into more detail about slicer pads later.

Grid Keyboard

Explore Sequences
Now that we know how to trigger the pads, let’s play some sequences. Before we do that,
let’s take a minute to turn off Song Mode. Push the white SONG button. You will see a list
of sections that have been created for this song. Touch the on-screen Song button to
toggle the state of Song Mode. The on-screen Song button is blue when Song Mode is
active, but for now let’s make it gray for inactive so we can focus on sequences.
Push SEQS to go to the Sequences screen with a grid of 16 sequence
cells. The cells that have sequences have dots in the mini-piano roll
icon on the cell. Touch one or more filled cells to make them active.
A white box appears around the active sequences. Push the black
PLAY button to play the active sequences. Touch sequences to turn
them on and off. There may be a delay in response as the blackbox
waits for the next quantization point before triggering the sequence.
Playing sequences have a blue progress bar at the bottom of the cell.
Sequences that are queued and waiting for a quantization break to
play have a white box in place of the blue progress bar. Push STOP
when you are done. Push STOP a second time to interrupt any pads
that continue to play out after the sequence ended.

Sequences

Select a sequence by touching the cell or turning a knob. The
currently selected sequence is highlighted pink. The number of this
sequence is displayed in the context bar above the grid. This is visible
on all of the top-level screens. This is the sequence that will capture
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the notes and pad triggers you play while recording. Push the INFO button repeatedly to
cycle through the piano roll and parameter pages for the sequence.
Select an empty sequence cell and we will record into it. Push PADS to go to the Pads
screen. Hold down the REC button and push PLAY to start recording a sequence. After
the 4 beat count down, tap some pads to create a sequence. By default, the sequence is
one bar long. Blackbox will play the sequence in a loop as soon as you finish recording it.
If you tap some more pads, you will add more pad triggers to the sequence. Push REC to
stop recording while the sequence still plays. You can choose different sequences to
record into while the other sequences are playing. Press STOP when you want the
sequences to stop.
Before we move on to song sections, go back to the SEQS screen and touch OFF on the
right. This will deactivate all sequences.

Explore Song Sections
Push the SONG button to go to the Song screen with its list of song
sections. Touch the on-screen Song button to enable Song Mode.
Notice that the context bar at the top of the screen now displays the
name of the currently selected section. Now press PLAY to play the
song sections in order starting with the selected section. You can
jump around between the sections by touching a section to make it
the next section. You can play a section on loop by touching the
Loop button at the top of the screen.

Song Sections

While a song section is playing, push the SEQS button to watch as blackbox plays the
sequences in the section. You can play additional sequences by making them active. This
will not add to the song section because you aren’t recording yet.
While a song section is playing, push the PADS button to watch pads being triggered by
the sequences in the song section. Touch a pad to trigger it and play along. On the Song
screen, turn the top left knob to adjust the BPM of the internal clock. The song will slow
down or speed up in real time as you adjust this. Turn the top right knob to adjust the
amount of swing in the notes. Push STOP to end playback of the song section.

Copyright 1010music LLC 2021

Page 15 of 106

Blackbox User Manual 1.7

Song Mode and REC | STOP | PLAY Buttons
Let’s talk about Song Mode and the transit buttons. When Song Mode is disabled, the
PLAY, STOP and REC buttons generally control the sequences. The one exception is when
you are recording a new sample on the Sample Recording screen. When Song Mode is
enabled, the PLAY, STOP and REC buttons control the song sections. The text in the top
middle of the top-level screens always indicates what will be the target of a recording
action. If Song Mode is disabled, this text will indicate which sequence cell is currently
selected, e.g. Seq 8. When Song Mode is enabled, this text will indicate which Song
section is currently selected, e.g. Inspiration. Here’s what happens when you use the
transit buttons in the different modes:
Song
Button Result
mode? Pressed
On

PLAY

Play the currently selected section plus any active
sequences.

On

REC +
Play

Record start and stop events for sequences and save this
in the selected section. This information is recorded as an
overlay, so you can add to a section over time.

On

STOP

Stop playing and recording all sections and sequences.

Off

PLAY

Play any active sequences. You can start and stop
sequences while playing. The sequences will play in a
loop until you press STOP or deactivate them.

Off

REC +
Play

Play any active sequences and record any PADS or KEYS
entries into the currently selected sequence. This is
recorded as an overlay so you can add to a sequence over
time. The sequences will play and record in a loop until
you press STOP or deactivate them.

Off

STOP

Stop playing and recording all sequences.

To record a song section, select the section you want to record into and then hold REC
while you press PLAY. Any sequences that are active at this time will start to play and be
recorded into the section. Touch sequence cells to activate and deactivate them and add
them to the section. If you record on top of a previously recorded section, it will add to the
content that is already there.
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To Save a Preset:
If you want to save the work you have done so far:
1.

Push PSET to display the Preset Screen.

2.

Touch File and then touch Save or Save As. If you choose Save As, you will have
a chance to save to a new preset so you don’t overwrite the original preset.
Note:
► Blackbox does not automatically save changes as you work. If you don’t
save your changes, the preset will remain in its original state on your
microSD card when you load a different preset, create a new preset or
power down blackbox.

Next we will create a new preset and dive into more detail about each of the functional
areas of blackbox.

Copyright 1010music LLC 2021
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CREATE A NEW PRESET
A preset is the master file that stores a blackbox composition. It holds the pad
assignments, sequences, song sections, FX settings, Mix settings and the detailed
parameters for each of these. Blackbox does not automatically save your work. You must
save the preset to avoid losing your work when you change presets or turn off the unit.

To Create and Name a Preset:
First, you will create a new preset that will be used to store your
creation. Follow these steps to create and name your preset:
1.

Touch the PSET button below the screen to display the
Preset Management screen. This screen shows a list of the
presets stored on the microSD card with a menu across the
top. The currently selected preset is highlighted in blue.

2.

Touch File then New in the top menu. Use the onscreen
keyboard to enter a name for the preset. Touch Enter to
save the name and return to the Presets screen with the
new preset selected.

3.

Push the PADS button to start working with your new
preset from the Pads screen.

Preset
Management

Preset File Menu
Note:
► When blackbox first starts up, it loads the last preset you used on this
microSD card.
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SCREEN NAVIGATION MAP
The diagram below shows the primary navigation paths through blackbox. You can use
this to see where we are going and where we have been.
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WORK WITH PADS
Each pad in blackbox can be assigned a WAV file or a folder of WAV files. You can
configure playback options, such as trigger mode and looping, individually for each pad.
Once a pad is loaded, you can touch the pad on the main Pads screen to trigger it. You
can also use the Keys screen to play the currently selected pad. When you trigger a pad
from the Keys screen, a pad with a single WAV file is pitch shifted to correspond to the
note played. Multi-sample pads play the WAV file with a root note closest to the played
note, with pitch shifting if needed. We’ll talk more about multi-samples later.

Steps Common to All Pad Modes
From the Pads screen you will choose WAV files to assign to pads and assign a mode to
each pad. The main screen has a 4x4 grid of 16 light gray pads. A WAV file can be assigned
to each of these pads, and each pad is assigned a Pad Mode.
Blackbox supports the following pad modes:

Icon

Pad
Mode
Sample

Description
Use to play single notes or
drum hits. You can control
start and end points for
playback and looping.
Supports reverse playback,
along with forward and
bidirectional looping.

Reverse
Playback

Beat
Sync

Set
Loop
Points

Play
Slices

Polyphony
16
notes

√

√

Sample:
MultiSample
Mode

Spread a folder full of wav
files across the keyboard
to get more realistic
instrument pitch shifting
or to map different sounds
to each key on the
keyboard.

16
notes

Clip

Use for synchronized loops
and quantized playback,
e.g. drum loops and guitar
tracks between one and
eight measures long.

2 notes
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Icon

Pad
Mode
Slicer

Granular

New
Recording
New Multi

Reverse
Playback

Description

Beat
Sync

Use with a WAV file with
different sections that
you want to trigger
independently.
Generate new sounds
from your samples. The
sample is played back in
small portions about 10
to 200ms in length,
called grains.

Set
Loop
Points

Play
Slices

Polyphony
2 notes

√
mono

√

√

Use to start recording a
new WAV file or clear a
WAV from a pad.
Automate recording of
multiple samples across
a range of notes
triggered via MIDI.

Each pad can have a different Pad Mode. You can use the same WAV file in different pads
in different Pad Modes.
To Load WAV Files and Assign Pad Modes:
1.
Push the PADS button to bring up the Pads screen.
2.

Select a pad by touching it or using the control knobs to cycle through the pads.
The top control knobs move the selection horizontally. The bottom left control
knob moves the selection vertically. The selected pad is highlighted pink.
Touching a pad that is loaded with a WAV file will also trigger playback of that
WAV file.

3.

Press the INFO button. If the pad was empty, the WAV Load and Record screen
will be displayed. If the pad already had a WAV file assigned, the Waveform
screen will be displayed.

WAV Load and
Record Screen

Copyright 1010music LLC 2021
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Screen
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4.

If you are on the WAV Load and Record screen, touch Load in the top menu bar.
If you are on the Waveform screen, touch the name of the WAV file at the top of
the screen (SY Chord1 LF in the example). You will now be on the WAV File
Selection screen.

5.

From the WAV file selection screen, use the control knobs to scroll through the
list of files. Blackbox displays the directories at the top of the list followed by the
individual files in alphabetical order. The selected file or directory name has a
blue highlight. Touch Play to preview the highlighted file. The Play button will
turn blue to show that auto-preview is enabled. Blackbox will play each WAV file
once when you pause on it while scrolling. If you have a sequence or a MIDI
input trigger playing for this pad, blackbox will play the selected WAV file
whenever a trigger is received for this pad. Touch the Play button again to
disable auto-preview mode. Touch Load to assign the selected WAV file to this
pad. When looking at the list of files, list items that start with a slash \ are
directories. Load a directory to see its contents. The file path is displayed above
the list of files (e.g. SoundtrackLoops\SL Bass Mu in the example above.) Touch
the caret ^ to navigate back up the directory tree. Touch the back arrow to go
back to the previous screen.
Note:
► There may be considerable differences in volume levels of WAV files
depending on how they were originally recorded. Be careful when
previewing the WAVs on the load screen or you could get a rude
surprise if you switch between soft and loud WAV files.

To View Wave with Start, End, Loop and Slice Points:
Once you have loaded a WAV file, you will be on the Waveform
screen. There are a number of important features on the Waveform
screen. The grid icon at the top left of the screen, immediately below
the clock counter, provides a graphical representation of which pad
in the grid you are configuring. You can touch it to bring up a pad
Waveform
selection grid. Touch a square in the grid to change which pad you
Screen
are working with. The icon just to the right of that is a button that
allows you to select the Pad Mode. The text in the top bar displays the first characters of
the name of the loaded WAV file, and can be touched to choose a different file. Trigger
playback by touching the arrow button on the right.
There are two views of the waveform displayed on the screen. The top view always
displays the full waveform in white with a blue rectangular outline indicating the
subsection of the waveform that is displayed in the bottom, bigger waveform. You can
use pinch and stretch touchscreen gestures to zoom in and out of the waveform, then
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swipe to scroll along the length of the waveform. You can quickly jump to a different
section of a long waveform by touching that section of the wave in the top view.
If the pad is in Sample or Granular mode, the bottom waveform shows a pink bracket that
indicates the portion of the WAV file that will be played by this pad. Turn the top left knob
to adjust the start position, and the top right knob to adjust the length. If this pad uses
looping, a white bracket is displayed to show the loop points. Turn the bottom two knobs
to adjust the loop start and loop end points.
If the pad is a Slicer, you will see pink bars that indicate the position
of the slices. If a wav has slices embedded in it, you may also see
slices when the pad is in Clip mode.
WAV Screen
with Slice Points
To Configure Pad Parameters and Choose a Pad Mode:
1.
Touch the icon immediately to the left of the WAV file
name at the top of the screen to display the Pad Mode
selector. Touch one of the options to set the Pad Mode. The
icon changes to represent the selected Pad Mode. See the
table at the beginning of this section for a description of
each of these modes.
2.

From the waveform screen, press the INFO button to
display the Pad Parameters Screen. Touch the buttons
across the bottom to access the different pages of pad
parameters. You can press INFO again to toggle between
the Pad Parameter screen and the Waveform screen.

3.

On the Main Pad Parameters page, there are four menu
items at the top, just below the measure and beat count.
The left most item is the grid icon and pad selector. Touch
this icon to change which pad you are editing. The pink
square in the grid indicates which pad you are currently
editing. The second menu item is the output selection
button (Out1 in the example). Touch this menu item to
display the list of output options:

Pad Mode
Selector

Main Pad
Parameters

Grid Pad
Selector
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Output
Option

Description

Out 1, 2, or 3

The output of this pad is sent to selected output in
stereo.

Out1L, 1R, 2L,
2R, 3L, 3R

The output of this pad is sent to the left or right stereo
channel of the selected output.

Output Selector

Note:
► The PHONES output jack will always contain a mix of all of the outputs.
4.

Touch the desired output option to select it.

5.

The next menu item (Mono in the example) controls the polyphony of the pad.
Touch the menu option and then select the Polyphony desired for this pad.
Sample and Multi-sample pads reliably support options ranging from Mono
through 8-note polyphony. If you select Poly X, the pad will use any available
voices, up to a max of 16 for the pad, and 32 total across all pads. Clip mode and
Slicer mode support mono and 2-note polyphony. Granular mode is
monophonic. Note that a max of 32 voices across all pads can be played at once.
Note:
► To optimize the performance of blackbox, use the lowest polyphony
required for each pad.
► Blackbox has been tested to reliably playback up to 24 simultaneous
voices. The absolute maximum number of voices is 32, but you may
encounter CPU issues before that depending on other demands on the
processor.

6.

The last menu item displays an abbreviated version of the WAV file name (PC O
and NAS_9 in the examples). Touch this menu item to start playback of the pad.
The playback functionality will depend on the other parameter settings. The
WAV file is playing when this menu item is highlighted blue. For Clips, when this
square is filled in white the clip is queued up to begin when the Play transport
button is pushed.

7.

As you push the buttons across the bottom of the Pad Parameters screen,
blackbox will cycle through the Pad Parameter pages. Some of the pad
parameters are the same for all Pad Modes, while others vary by mode. Touch
the control knob closest to each parameter to set its value. Here are the
parameters that are the same for all Pad Modes:
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Parameter Description

Range of Values

Mod
Target?

Level

Adjusts the loudness level of the pad

-24.0 to +24.0 semitones

Yes

Pitch

Adjusts the pitch of the pad up or
down

-24.0 to +24.0 semitones

Yes

Filter

Applies either a high pass or low pass
filter to this pad.

-100% to +100%
Negative values apply a low pass filter.
Positive values apply a high pass filter.

Yes

Launch
Mode

This controls how a note trigger
affects the playback of a pad.

Trigger: Activate the Pad by touching the No
pad or through MIDI note on. Blackbox
will start playback of the WAV file and
play through to the end.
Gate: Begin the WAV file playback in the
same manner as Trigger mode. But in
Gate mode, playback will stop when you
release the touch or the MIDI note is
released.
Toggle: Begin the WAV file playback in
the same manner as Trigger mode.
When another trigger event happens,
the playback will stop.

Attack

The time it takes for the sound to
reach its loudest level.

0.0 to 100.0% The attack percentage is a
logarithmic scale between 0 and 9
seconds.

No

Decay

How long it takes for the sound to go
from the initial peak to the sustain
level.

0.0 to 100.0% The decay percentage is a
logarithmic scale between 0 and 38
seconds.

No

Sustain

The volume level that the sound
maintains when you hold a note.

0.0 to 100.0%

No

Release

The release specifies how long the
0 to 100% The release percentage is a
note will continue to play and fade
logarithmic scale between 0 and 38
out when the note is released. In Gate seconds.
mode, the release begins when the
touch ends, the gate signal goes low,
or the MIDI note off event occurs. In
Toggle mode, the release begins
when the toggle off occurs. In Trigger
mode with sample pads the release
begins when reaching the Loop End
point in loop mode, or the Start + Len
point when not looping. In Trigger
mode for Clips and Slicers, the release
has no effect.
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Parameter
MIDI In

Description
Specifies a MIDI channel to be used
to play this pad chromatically or
sliced across keys. This channel is
also used for MIDI modulation of
some parameters.

Range of Values

Mod
Target?

None, Ch1 through Ch16.

No

MIDI Out

Specifies a MIDI Channel that will
None, Ch1 through Ch16.
be used to send out notes when this
pad is triggered. When this pad is
triggered using notes, the
corresponding note will be sent out
on the specified MIDI channel. If
this pad is triggered as a pad hit,
note 64 will be sent out on this
channel. Please note that
Sequences can also be assigned to
MIDI Outputs. See the section Use
MIDI Devices with Blackbox below
for more information about MIDI
Outputs.

No

Pad Note

Controls which MIDI note on the
MIDI Pads channel will trigger
playback of this pad.

No

More than one pad can be assigned
to the same MIDI channel. In this
case, all assigned pads will be
triggered.
Any MIDI channel that is mapped to
a pad using this parameter no
longer triggers any events for MIDI
parameters set to OMNI.
Modulation sources PTCH (pitch
bend), MODW (Modulation Wheel),
MVOL (Volume control), and MPAN
(Pan control) follow this channel
assignment.
See the section Use MIDI Devices
with Blackbox below for more
information.

Default, C#-1 through G9.
C#-1 maps to MIDI Note Number 0.

Note:
► The remaining parameters are specific to each Pad Mode (sample,
multi-sample, clip, slicer or granular). We will discuss each Pad Mode
individually in the next sections.
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8.

9.

At the top of the ADSR parameters page, the menu option
to the right of the grid icon allows you to control exclusive
grouping of pads. Touch this menu option, Excl C in the
screenshot, to see the options. Touch an option to select it.
When Excl X is selected, there will not be an exclusive
behavior for this pad. When a pad is assigned to Exclusive
Group A, B, C or D, any other pad in this group will stop
whenever a pad in the group is triggered.

Pad Exclusive
Groupings

To the right of the exclusive grouping option is the Playback quality option, set to
Normal in the screenshot. For most WAV files, the normal mode provides high
quality playback with a moderate draw on the processor. If you hear aliasing
during playback of your WAV file, touch this button and select HighQ mode.
HighQ mode has a higher draw on the processor, so it is recommended that you
use Normal mode unless you are having issues.

Several of the pad parameters have three black boxes below them. These pads are
potential modulation targets, and these boxes are used to control the modulation
parameters. We will discuss modulation later in the Work with MIDI Inputs section.
There are additional configuration options for a pad that vary based on which Pad Mode
is selected. We will walk through the configuration of each of the Pad Modes next.

Set Up a Sample Pad
Use a sample pad when you only want to play or loop through a WAV file with no slicing
and no beat synchronization within the playback. This can be useful for playing one-shots
like drum sounds, or playing melodies using samples for the notes. You can also use this
mode when you have a bank of samples that you want to map across the keyboard. This
can be used to map different sounds to different note triggers, or to map the same
instrument recorded at different pitches across the notes on the keyboard to get
improved pitch shifting across a broader range of notes. We will first discuss Sample
mode pads loaded with a single sample, and then explain the special case of multisamples.
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Single Sample Pads
A sample pad loaded with a single sample supports reverse playback, along with forward
and bidirectional looping. You can also use the Start and Len parameters to play a portion
of the WAV file.

Sample Pad
More Sample Pad
Parameters
Parameters
Follow the steps in the previous section to create a sample pad. An example of a good
WAV file to use for a sample pad is \drums\Kick 1.wav. Press the INFO button to toggle
between the Waveform screen and the Pad Parameters screen. Touch the buttons across
the bottom of the parameters screen to access the various parameter pages for this pad.
Use the control knob closest to the parameter name to change the value of a parameter.

Pad Parameters Specific to Sample Pads
Parameter Description
Loop Mode

Controls whether the WAV file plays in a loop,
and the direction of the loop.
When looping is enabled (Forward or Bidirect),
if you have the Launch Mode set to Trigger,
looping will happen for the duration of the
Release phase of the note.
If you have the Launch Mode set to Gate,
looping plays through the gate pulse and the
release time.
If you have the Launch Mode set to Toggle,
looping starts to play when the initial pulse is
received and continues until the terminating
toggle pulse is received.
If Loop Mode is Bidirect, and Rev is ON,
playback will start from the end of the sample,
and then loop as described, but starting with
the Loop End to Loop Start pass.
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Range of Values
None: Plays once from the
value assigned to the Start
parameter through the value
assigned to the Length
parameter.

Mod
Target?
No

Forward: Plays from the value
assigned to the Start
parameter through the value
assigned to the Loop End
Parameter, then jumps back
to the value of the Loop Start
parameter. Play continues to
loop between Loop Start and
Loop End for the duration of
the note.
Bidirect: Works similarly to
forward, but loop playback
proceeds from Loop Start to
Loop End then backwards to
Loop Start. It then repeats the
looping back and forth.
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Parameter Description

Range of Values

Mod
Target?

Rev

When Reverse is ON, the WAV file will play in
reverse.

ON, OFF

No

Loop Fade

The amount of cross-fading that will be applied
0 to 100%
when transitioning from the end to the
beginning of the loop. This parameter is only
active when Loop Mode is Forward. This is a
percentage of the loop length. The Loop Start
point must be greater than zero for this to work.
Blackbox will use a copy of the WAV signal from
just before the Loop Start point that is of a
length of the loop fade of the loop length. It will
then fade in that signal so that it ends just at the
Loop End point. In this way, you can smooth out
the transition at the loop point.

No

Root Note

The base sample will play for the note specified
here. The sample will be pitch shifted up or
down one semi-tone for each note away from
the root note. This will load from the WAV file if
available when you add the WAV to the preset.
You can specify a different value here to be used
for this WAV on this pad in this preset.

None, C#-1 through G9

No

When None is specified, the sample is assumed
to have a root note of middle C.
If you save the WAV file from this pad, the Root
Note value will be saved with it.
Start

Point where playback will begin when playing
forward or ends when playing in reverse.
Expressed as the number of the sample to be
played first.

0 to number of samples in the
file

Yes

Len

When Loop Mode is None, how long the sample
will play past the value of the Start parameter.
Expressed in number of samples.

0 to number of samples in the
file

Yes

LpStr

Point where the looping will begin when
playing forward, or looping will end when
playing in reverse. Expressed as a sample
number. Must be before or equal to LpEnd.

0 to number of samples in the
file

Yes

LpStr is read from the WAV file when sample is
loaded, and saved to the WAV file when the
WAV is saved.
LpEnd

Point where the looping will end when playing
LpStr to number of samples in Yes
forward, or looping will begin when playing in
the file
reverse. Expressed as a sample number. Must be
after or equal to LpStr.
LpEnd is read form the WAV file when a sample
is loaded, and saved to the WAV file when the
WAV is saved.
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You can also set the values for Start, Len, LpStr and LpEnd from the Waveform screen.
When viewing the waveform, the pink frame on the large waveform represents the Start
and Len parameters. You can move these end points by turning the top two control
knobs. If Loop Mode is set to Forward or Bidirect, you will also see a white frame within
the pink frame that defines the Loop Start and Loop End points. Use the bottom two
control knobs to adjust these end points. The corresponding values for the end points are
displayed above and below the large waveform. The sensitivity of the control knobs
depends on the Zoom level. Zoom out to make big adjustments then zoom in to make
fine adjustments.
Loop Fading
Let’s talk a little more about loop fading. Loop Fading is a
good way to smooth the transition when looping a sample.
The diagram to the right shows how the loop cross-fading
is applied at three different settings for the Loop Fade
parameter. The colored bars in the diagram represent
different equal length sections of the WAV file. The loop
points have been configured so that sections E, F, G and H
of the WAV file are looped. When Loop Fade is zero,
blackbox does not overlay any extra content on top of the
looped sections.
When Loop Fade is 25%, section D, which is a section of
WAV that is 25% of the length of the loop from immediately
before the loop start point, would be gradually faded in over
the last 25% of the looped section. So as section H starts,
section D fades in and section H is gradually faded out until
on D is left as we reach the loop point.
When Loop Fade is 100%, sections A, B, C and D are faded in
on top of sections E, F, G and H.
Note:
► In order for the Loop Fade to work to the full extent, there must be
enough audio signal before the Loop Start point to draw from. For
example, if your WAV file is 1000 samples long, and your Loop Start is at
250 samples, you only have 250 samples, or 33% of the loop length,
before the Loop Start point to use for Loop Fading. You can set the
Loop Fade to a higher number, but it won’t be able to add additional
improvement because there’s no signal available to use.
► To minimize the impact of Loop Fading on CPU usage, use the smallest
value for Loop Fade that gets the sound quality you need. This will vary
based on the sample.
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Multi-Sample Pads
When you pitch shift a single sample across the entire range of the keyboard you may get
less than stellar results. A better approach is to record multiple samples across the range
of the keyboard and let the sampler interpolate the sounds between the available notes.
The more samples you use, the less stretching the sampler has to do, and the better the
resulting sound. Multi-sample pads are mapped to multiple WAV files. If the WAV files
contain root notes embedded in them, blackbox will play the corresponding WAV file
when that note is played, and use pitch shifting to create the notes in between. If there
are no root notes defined, blackbox will load the files in alphabetical order and map one
file to each successive note, starting at C2. You can also use this approach to map a list of
different sounds across the keys of the keyboard, for example if you want to map different
drum sounds to different notes.
To Load a Sample Bank into a Multi-Sample Pad:
1.
Put the files you want to use in one multi-sample pad into a single directory by
themselves. There are several folders of samples like this in the \Symplesound
folder included with the 1.3 firmware update. If you are registered for our forum,
you can download this content at https://forum.1010music.com/forum/productdownloads/sampler-content-bundles.
2.

Push the PADS button to bring up the Pads screen.

3.

Select a pad by touching it or using the control knobs to cycle through the pads.

4.

Press the INFO button. If the pad was empty, the Load and Record screen will be
displayed. If the pad already had a WAV file assigned, the Waveform screen will
be displayed.

5.

If you are on the Load and Record screen, touch Load in the top menu bar. If you
are on the Waveform screen, touch the name of the WAV file at the top of the
screen. You will now be on the WAV file selection screen.

6.

From the WAV file selection screen, use the control knobs
to scroll through the list of files and directories. The
selected file name has a blue highlight. When looking at
the list of files, list items that start with a slash \ are
directories. Load a directory to see its contents. The file path
is displayed above the list of files. Touch the caret ^ to go
back to the previous directory. Highlight one of the files in
the directory of samples that you want to load into the pad.
A good example of a directory to use with multi-samples is
\Symplesound\Housepiano. You can select any file within
that directory.

7.

Touch File and then Load All.
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Blackbox will now load all of the files in the current directory into this pad and map the
files to notes across the keyboard based on the root notes defined in the WAV files. Now,
use the KEYS screen or an external MIDI controller to play notes for that pad. Blackbox will
play the sample with the root note that is closest to the note played, and pitch shift as
needed to achieve the necessary tone.
You can also use multi-sampling to map multiple waves across the keyboard. This can be
useful if you have a folder full of drum sounds that you want to trigger with a keyboard. If
you follow the steps above and load a folder where the files do not have root note
mappings, it will load the files in alphabetical order, map the first file to note C2, and then
each subsequent file to the next note above that. If you load the folder
\SoundtrackLoops\SL Acoustic kit, you can see this in action. This folder has 16 drum
samples which get mapped to notes C2 through D#3. Notes below C2 will play the first
WAV file pitch shifted down the appropriate number of half steps.
You can use blackbox to map the files to specific notes if you want. Open the files as
individual samples on blackbox and edit the Root Note on the Misc tab of the Parameters
screen. Save the WAV file with the root note information. To save the WAV file, push Info
on this pad to display the WAV form screen. Touch the WAV file name at the top of the
screen, then touch File and Save. After you have done this for all of the files in the folder,
use File-> Load All to load them all into a pad. Now when you play the pad chromatically
you will hear this root note mapping in use.
Because a multi-sample pad uses multiple WAV files, it is not possible to set start, length,
loop start or loop end points for these pads. Therefore, it doesn’t make sense to enable
looping for these pads either. As a result, the POS and MISC tabs of the parameter page
are not used when multiple samples are loaded in a pad. Only the standard Main, ADSR
and MIDI parameters are supported for Multi-samples.
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Note:
► Multi-sampling can quickly use a lot of samples. In order to prevent
potential issues, blackbox limits you to loading 80 WAV files at a time.
If you hit that limit, it won’t load any more wav files until you free up
some slots by clearing out a pad. There is also a limit of 64 WAV files
per pad.
► If you change the pad mode of a multi-sample pad to something other
than sample, it will load only the first sample in the folder and work
with that. You will need to reload the files to change back to multisample mode.
► Anytime you use File -> Load All to load a directory of samples into a
pad the pad mode will automatically be changed to Sample.
► Blackbox helps you automatically record a multi-sample bank of an
instrument that can be triggered via MIDI or CV. See Recording New
WAV Files below to learn how to do this.
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Work with a Clip Pad
Use Clip Mode for WAV files where you want to use synchronized
loops and quantized playback for the entire WAV file. Clip Mode
works well with drum loops between one and eight measures long,
but there is no hard limit to the length. This is the only Pad Mode
that supports beat synchronization. An example of a file that works
well with Clip Mode is \SoundtrackLoops\SL LoFi Hip Hop2\SY L
Pad14 A Melody2 08. This clip is used in the preset SL LOFI HIP HOP
KIT 2.

Clip Parameters

Note:
► In order to synchronize the clips, there has to be an available clock.
Blackbox only uses the clock when in Play mode. Therefore, you must
push Play before playback of a clip pad will begin. If you trigger a clip
pad before you push Play, a white bar will appear below the pad to
show that it is queued up and ready to start. The name of the pad in
the top right corner of the parameters screen will be replaced with a
white square until you push Play.
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Pad Parameters Specific to Clip Mode
Parameter Description

Range of Values

Mod
Target?

Loop Mode

Controls whether the WAV file plays in a loop.
The whole WAV file will be played in the loop for
clip pads. Only forward looping is supported
with clip pads.

On, Off

No

Beat Count

Enter the number of beats in the clip file to give
blackbox more information to work with when
synchronizing playback to the current song
BPM. If set to Auto, blackbox will attempt to
detect the beat count automatically.

Auto, 1 to 512

No

Quant Size

Use Quant Size to quantize when the playback
starts and stops. Quantization will cause
playback to snap to a musical grid with intervals
specified by the Quant Size parameter. When
quantization is used, the note trigger will cause
playback to start and end on the next Quant Size
boundary. For example, if the Quant Size is set to
1-bar and you press the pad, the playback will
begin at the start of the next bar.

None - always start and stop
immediately

No

Sync is only enabled when quantizing is enabled
(the Quant Size parameter is not None). The
Sync feature prevents timing drift that can occur
when the length and BPM of a clip does not
align exactly with the tempo of playback. When
Sync is used, blackbox will realign the audio to
match the clock at the step size specified here.

None – playback will occur at
the original rate. Looping will
happen as soon as the sample
ends.

Sync

Even slight differences between WAV file BPM
and clock tempo can cause significant drift over
time. Select a value for Sync that will control the
size of the musical unit to which the clip will be
synchronized. Choose small settings, like 1/16th,
for rhythmic or percussion clips. Choose large
settings, like 1-bar, for sustained tones or drones
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1/16, 1/8, 1/4, 1/2, 1 bar, 2 bars, 4
bars, 8 bars

No

1/16, 1/8,1/4, 1/2, 1 bar, Slice (See
To Use Slices to Synchronize
Playback of Clip Pads below
for more information.)
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Clip Mode and Quantization
Let’s talk some more about Quant Size and Sync. When a Quant Size other than None is
selected, the playback of the wave file will be delayed until the next selected unit of music
as specified in Quant Size. This will ensure that your playback “snaps to the grid” of the
beats established by your clock. Sometimes the WAV file you are playing is longer than
one beat. For example, the WAV file might contain a 2 bar drum riff. For a clip pad,
blackbox will make some assumptions about where the beats in your file occur. In Clip
mode, blackbox will play the whole 2 bar riff when the note is triggered. But the beats in
the WAV file might not be playing at the same tempo as the clock speed. If you leave
Sync set to None, the WAV file will play in its entirety and will get out of sync with your
clock. If your WAV file tempo is faster than your clock tempo, it will sound like the beats
are running ahead of the rest of the music. If your WAV file tempo is slower than your
clock tempo, it will sound like your drums are lagging. If you want to fix that, then choose
the value for Sync that identifies how tightly you want to snap to the clock while the WAV
file is playing in response to a single sustained note trigger. While the note is playing, the
sync will cause the playback of the WAV file to jump to the next selected sync increment
in the file when the corresponding clock time has passed. So if the WAV was a little faster
than your clock, the playback position will jump backwards to move the playback of the
WAV to the selected clock increment. If the WAV is slower than your clock, the playback
position will jump ahead to the selected clock increment. This will work well if the
difference between the BPM of your WAV file and the BPM of your clock is small. It will
sound like a stutter if the difference is large.
Note:
► Blackbox assumes your clips use 4:4 time. If you are using other time
signatures or polyrhythms, blackbox will have trouble synchronizing
the clip.
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Tips for Synchronizing Clips:
■ Make sure your WAV file starts at the beginning of a measure and ends at end of a
measure. There should be no blank space at either end and it should loop cleanly at
full length.
■ Help blackbox determine the beat count. Blackbox will use the following methods
in this order to identify the beat count:
▪

Look at the BeatCount parameter when it is not Auto

▪

Look for a valid ACID Tag in the WAV file that includes the beat count

▪

Try to calculate it using the following assumptions:
◦

the time signature is 4:4

◦

the beat count is a power of two (2, 4, 8, 16, 32, 64, …)

◦

the clip tempo is close to the current clock tempo

Work with Slicer Pads
Slicer mode is useful when a single WAV file has multiple sections that you want to
trigger independently. For example, if you have a drum riff, you may want to trigger
different drum hits within the drum riff independently. Or if you have a recording of a
vocal track, you may get an interesting effect if you skip around to playback different
words or phrases over time.
In order to use Slicer mode effectively, you will need to identify slices
within the WAV file. Blackbox can automatically detect the slice
points within the wave file, and you can manually add or remove
slice points. The WAV files in the folder \LOOPMASTERS\01
Loops\Drums and Perc\Full Drum Loops are good examples to try
with Slicer mode.
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Pad Parameters Specific to Slicer Mode
Parameter Description

Range of Values

Mod
Target
?

Loop Mode

Controls whether the slice playback is
looped. This does not work with Launch
Mode of Trigger. Use Launch Mode of Gate
or Toggle if you want to loop slices.

ON, OFF

No

Beat Count

Enter the number of beats in the clip file to
give blackbox more information to work
with when synchronizing playback to the
current song BPM. If set to Auto, blackbox
will attempt to detect the beat count
automatically. Only used when Sync is set
to ON.

Auto, 1 to 512

No

Quant Size

Use Quant Size to quantize when the
playback starts and stops. Quantization will
cause playback to snap to a musical grid
with intervals specified by the Quant Size
parameter. When quantization is used, the
note trigger will cause playback to start and
end on the next quant size boundary. For
example, if the Quant Size is set to 1-bar
and you press the pad, the playback will
begin at the start of the next bar.

None - always start and stop
immediately

No

The Sync feature prevents timing drift that
can occur when the length and BPM of a
clip does not align exactly with the tempo
of playback. When Sync is used, blackbox
will realign the audio to match the clock at
the step size specified here.

OFF – playback will occur at the
original rate. Looping will happen
as soon as the sample ends.

Sync

1/64, 1/32T, 1/32, 1/16T, 1/16, 1/8T,
1/8, 1/4T, 1/4, 1/2T, 1/2, 1 bar, 2 bars.
Assumes 4/4 time.

No

ON – blackbox will synchronize the
playback of the slice.

Even slight differences between WAV file
BPM and clock tempo can cause significant
drift over time. Select a value for Sync that
will control the size of the musical unit to
which the clip will be synchronized. Choose
small settings, like 1/16th, for rhythmic or
percussion clips. Choose large settings, like
1-bar, for sustained tones or drones.
Slice

Indicates which slice will be played when a
note is triggered. You can use modulation
to vary this value over time.

Page 38 of 106

1 through the number of slices in
the pad.

Yes

Copyright 1010music LLC 2021

Blackbox User Manual 1.7

Parameter Description
Slice Seq

Range of Values

Mod
Target?

When Slice Seq is set to a value other
than None, each new note will
advance the selection of the next
slice to play.

None: This parameter will not be used to
control the order of playback of slices.

The value of this parameter controls
the order in which slice selection is
advanced.

Backwards: A trigger will cause the
playback to move to the previous slice

No

Forward: A trigger will cause the
playback to move to the next slice.

Random: A trigger will cause the
playback to move to a randomly selected
slice
Stagger: A trigger will cause the
playback to move through the slices in a
somewhat random way. It will move
forward a few slices, then back a couple
of slices, and repeat.

PlayThru

Controls whether or not playback
continues through the end of the
slice.

ON – playback will continue past the end
of the slice to the end of the file.

No

OFF – playback will stop at the end of the
triggered slice.

In addition to setting parameters for a slicer pad, you also need to create the slices. There
are three ways to do this: manually, auto scan, and slice to grid. When you configure slices
manually, you use the Split and Join menu options to add and remove slice points. The
manual process may also be used to refine the results after you use auto scan or slice to
grid. When you use auto scan, blackbox uses an internal algorithm to decide where to
place the splits. You can control the sensitivity of the algorithm. When you use slice to
grid, you define a fixed number of slices, and blackbox will create splits that evenly divide
the WAV file into the specified number of slices.
To Manually Create or Remove Slices:
1.
On the Waveform screen for the slicer pad touch the menu
item with the three dots “. . .”. This will display the Waveform
Slicing menu.
2.

3.

Use touch gestures to move the waveform so the fixed
cursor position (the vertical white line) is at the position
where you want to add another slice point. Touch Split to
create a slice point. The slice point is shown as a pink
horizontal line with a small pink square near the bottom.

Waveform
Slicing Menu

Use touch gestures to move the waveform so the fixed
cursor position (the vertical white line) is on or near a slice
point that you want to remove. Touch Join to remove the
slice point.

You can have as many or as few slices as you want.
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To Use Auto Scan to Create Slices:
1.
From the Waveform screen for the slicer pad, touch the
menu item with the three dots “. . .”. This will display the
Waveform Slicing menu.
2.

Touch Scan and then use a control knob to select a
Threshold percentage for the sensitivity of the scan. The
lower the threshold, the higher the number of slices that
will be created. Touch OK when you are ready to scan. (You
can touch anyplace outside of the Threshold field to cancel
the scan.) Blackbox will detect and create slice points in the
file automatically. The slice points are shown as pink
horizontal lines with a small pink square near the bottom.

Scan Threshold

To Use Slice to Grid:
1.
From the Waveform screen for the slicer pad, touch the
menu item with the three dots “. . .”. This will display the
Waveform Slicing menu.
2.

Touch Grid and then use a control knob to select the
number of Slices to create. Touch OK when you are ready to
scan. (You can touch anyplace outside of the Slices field to
cancel the scan.) Blackbox will automatically divide up the
WAV file evenly into the number of slices you specified. The
slice points are shown as pink horizontal lines with a small
pink square near the bottom.

Grid Slice
Selector

You can adjust the results of the slice to grid or auto scan by
manually adding or removing slices to get the slices that match your
creative vision.
To Use Slices to Synchronize Playback of Clip Pads:
You can use slices in a clip pad to synchronize playback of the beats in the clip. When the
value of the Sync parameter for a clip pad is set to Slice, blackbox will use the location of
the slices in the WAV file as the location of the “beats” for Sync purposes in order to
prevent timing drift.
But how do you get slices in a clip pad? First configure the pad in Slicer Mode, create the
slices, then change the Pad Mode to Clip. The slices will still be visible on the Waveform
screen and can be used for synchronization.
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Work with Granular Pads
The final pad mode is granular mode. Granular is similar to sample mode, but with the
additional ability to use multiple grains when playing back your sample. You can use
granular to facilitate loop cross fading and to generate new sounds from your samples. In
this mode, the sample is played back in small portions about 10 to 200ms in length, called
grains. You can control the size, count, spread and playback speed of the grains.

Pad Parameters Specific to Granular Mode
Granular pads support the same parameters as sample pads, except for Loop Fade. They
also use the following additional parameters:
Parameter Description

Range of Values

Mod
Target?

Grain Size

The size of the small segments of the WAV file that
will be played, measured in number of samples.

1024 to 16384, which is
about 10ms to about
200ms

No

Grain Count

How many different grains are layered together
during playback.

2 to 8. Keep in mind that
more grains require
more processor power.

No

Spread

The width of the range from which the grains are
randomly chosen for playback. The range is centered
around the current playback position in the WAV file.

Speed

How quickly the playback of the grains advances
through the source WAV file. At 100% it will sound
most like the original file. At 50% it will be half speed.
At 200%, it will progress through the WAV file at
twice the original rate.
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Recording New WAV Files
Blackbox comes with over 800 WAV files loaded on the microSD card and allows you to
load your own WAV files on the microSD card. You can also record new WAV files to create
your own custom sound. You can record a single WAV, or you can use MIDI or CV
automation to record an entire multi-sample bank.
To record a single WAV file:
1.
Start by plugging an audio signal source
into the Audio In jack. This is a stereo
input.
2.

Push the PADS button to display the
sample bank.

3.

Touch a pad in the grid to select it. With
the pad selected, press the INFO button.

4.

In the top menu, touch the button to the left of the Load button. This will display
the recording mode menu. Touch 1x to record a single file.

5.

At the top of the WAV File Load and Record Screen, you will see the level meters
for the two channels followed by a list of recording parameters. Turn one of the
top two knobs to select a parameter, and then turn one of the bottom two knobs
to select a value for that parameter. The table below shows the list of available
parameters for single WAV file recording.

WAV File Load
and Record
Screen
If the pad is empty, blackbox will display the Load and Record screen. If the pad
is already loaded, blackbox will display the Waveform screen. If you are on the
Waveform screen, press the Pad Mode icon to the left of the WAV file name at
the top of the screen and then touch New Recording. You will now see the Load
and Record screen.

Parameter

Description

Range of Values

Rec Input

Sets whether you are recording from only one
input, the stereo input pair, or re-sampling the
audio currently being generated to OUT1.

L+R, Left, Right, Resam

Gain

The VU meters represent the level of the signal
to be recorded. You can adjust the gain to get
the desired level and avoid clipping. For best
results leave some room (a few dB) between
your loudest level and the max allowed, which is
0dB. If a red bar appears to the right of the level,
the signal is clipping and the level of the input
signal should be lowered for best quality.

-96.00 dB to +20.00 dB

Mon Output

Controls where the input signals received
Out 1, Out 2, Out 3, Out1L, Out1R,
through IN1 and IN2 are played out to enable you Out2L, Out2R, Out3L, Out3R
to monitor the recording.
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Parameter
Length

Description
This parameter allows you to specify a
length of time that you want to record,
in terms of notes and bars.

Range of Values
Custom, 1/4, 1/2, 1 bar, 2 bars, 4 bars, 8 bars, 16
bars, 32 bars, 64 bars, 128 bars

When Custom is selected, touch the
Stop button to stop recording.
Rec Quant

This parameter lets you quantize the
recording to start and stop at the
designated musical time interval. This is
not available when Threshold recording
is enabled.

None - always start and stop immediately
1/16 - quantize to the next sixteenth note time
1/8 - eighth note
1/4 - quarter note
1/2 - half note
1 bar - a whole note assuming 4/4 time
2 bars
4 bars
8 bars

RecThresh

When set to On, recording will not start
until the audio input meets or exceeds
the audio level set in the Threshold
parameter.

On, Off

Threshold

When threshold recording is enabled,
this controls the minimum sound level
required to trigger recording to begin.

-96.00 dB to +12.00 dB

Rec Mon

Controls whether the input signal
received through Audio IN is played out
through Out1 and Out2 to enable you to
monitor the recording.

Off - Inputs are never played through the
outputs.
Auto - Inputs play through the outputs while
recording or the recording screen is visible.
On - Inputs always play through the outputs.

RecToPlay

When to set to On, blackbox will
automatically start to play the new
sample when recording ends if the
Length parameter was used for
recording.
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6.

Send a signal to the audio Input. The source will play through the selected
output if the Rec Mon setting is ON or Auto. The VU meters at the top of the
screen display the input levels. Adjust the gain as needed.

7.

To start recording, hold the REC button while you press the PLAY button.
Note:
► If you have the global Lead In option enabled (See Tools below),
Blackbox will wait four beats and then will start recording.
► If RecThresh is ON, the recording will start once the input level meets
the threshold level specified in the Threshold parameter.
► If you selected a time value for Length, recording will stop after the
selected length of time.
► The Load and Record screen displays a running clock of measures and
beats and time while recording.
► There may be a delay between when you push Rec + Play and when
the recording starts as blackbox waits to quantize the recording to the
selected Rec Quant time interval. See Synchronize Playback with a
Clock below for more information about clocks and quantization.

8.

Push Stop to end recording. There may be a delay between when you touch
Stop and when the recording ends due to quantization.

Note:
► When the recording has stopped, the PADS screen is displayed with the
new WAV file loaded in the selected pad. The pad name will be RC with a
numeric suffix. We will discuss changing file names and managing WAV
files in Manage WAV Files below.
► If you set the parameter RecToPlay to ON, blackbox will automatically
start to play the new sample when recording ends, if the Length
parameter was used for recording.
► The new WAV file is stored on the microSD card in the folder associated
with the preset. This folder is located under \Presets and has the same
name as the preset. For example, if your preset name is KickinGroove
then your recordings will be in the folder \Presets\KickinGroove.
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Working with WAV Files Recorded on Blackbox
How you will work with these files depends on whether you are recording samples to
build a library to use in presets in the future, or whether you are recording WAVs
specifically for the current preset.
If you are recording WAVs for the current preset:
1.
Record WAVS until you get the files you need. The WAVs are stored in the preset
specific folder.
2.

Assign the WAVs you want to use to individual pads.

3.

Push Preset and then touch File->Pack to create copies of any of the other files
used in the preset into the preset folder.

If you are recording WAVs to build up a library of sounds:
1.
Create a new preset to host the content from your recording session.
2.

Record into pads as desired. Blackbox places the WAV files into the preset’s
folder.

3.

You can optionally use your computer to move the WAV files from the preset’s
folder on the microSD card into sound library folders on the card. When you
want to use these files in another preset, point to the WAV files you moved to
the library folders. Then pack up those presets to preserve copies of the WAVs
you used for each preset.
Note:
► Blackbox won’t stop you from loading a WAV file from a Preset B folder
into Preset A. However, if you do this, you could potentially break Preset
A if you ever move or rename Preset B for any reason. Therefore, if you
have WAV files that you want to re-use across presets, we encourage
you to move these WAV files into library folders outside of the \Presets
folder, and to Pack your presets often.
► If you record into a loaded pad, the original WAV file remains intact on
the microSD card and a new WAV file is created.
► You can turn off the Lead In and Metronome on the TOOLS pages.
► Blackbox streams the recording directly to your microSD. The length of
your recording is limited to the space available on the microSD card.
Check available space on the TOOLS pages.
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Advanced Recording Techniques
To Record a Single WAV File while Sequences or Song Sections are Playing:
You can record WAV files while you are also playing sequences or song sections.
1.

Set up the sequences or song sections you want to play, and start playback.

2.

Go to the WAV Load and Record screen and configure the empty cell.

3.

Push Rec while on the WAV Load and Record screen and the sequences or
sections are playing.

4.

Push Rec again if needed to stop recording. The sequences or sections will
continue to play. If you have Rec to Play enabled, the pad will also start to play.
Configure looping and other options as desired.

To Use Resampling to Layer Recordings and Save Effects:
If you like the sound of a specific effect on a pad, or you want to layer sounds into a single
sample, you can record this to a new WAV file. You can also record a Sequence to create a
new clip. To do this, configure the source pads to play to Out1. Use Clip mode, an external
controller, or a Sequence to trigger playback of a single pad. Set up a sequence you want
to record. Set up a different pad for recording and set the recording input to RESAM, then
start recording.
1.

Configure a pad you want to resample by loading a WAV file, applying effects,
and configuring other parameters as desired.

2.

To be able to trigger the pad while recording, you will need to either set up an
external controller to trigger the pad, configure and arm a sequence to trigger it,
or set it up as a Clip and arm it for playback.

3.

Set the output for all pads to be recorded to Out1.

4.

Open an empty pad for recording. Set the Rec Input parameter to Resam. Set
up the other recording parameters as desired.

5.

Push Play and Record at the same time. This will trigger the armed Sequences
and Clips and start recording. Trigger additional pads or sequences using an
external controller if desired.

6.

Push STOP to end recording. You will now have a new WAV file that has all of the
audio signal sent to Out1 while recording.
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To Manually Record a Multi-sample Pack:
1.

Create a preset for the multi-sample pack. Let’s call it MyBank.

2.

Record the files into the new MyBank preset. Delete any extra files that are not
needed.

3.

Assign root notes to each of the files if you want to ensure blackbox maps the
files to the correct note. For example, if you recorded a sample for C3 and you
want that sample to be used when you play C3 and pitched shifted for notes on
either side of it, then set the Root Note parameter for that WAV file to C3. Do this
for each of the pitched samples that you recorded. This means you will have to
load each WAV into a pad individually in order to set the Root Note. Be sure to
save the WAV file after you set the Root Note so the setting will be saved into
the file. See Save and Load Parameters in WAV Files below to learn how to save
the Root Note.

4.

Open the Preset where you want to use the multi-sample pack. Let’s call it
MySong.

5.

Create a new sample pad and use Load All to load the multi-sample preset’s
folder into the sample. For our example, that would mean using Load All for the
folder \presets\MyBank into the multi-sample pad.

6.

Pack up the target preset (MySong in our example) to copy the multi-sample
files into a sub-folder under the target preset’s folder. In this case, you would end
up with the following folder:
\Presets\MySong\MyBank

7.

Now you are free to delete or move the original MyBank preset if desired, or
leave it there for future re-use.
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To Record a Multi-Sample Bank using MIDI or CV + Gate Automation:
You may have a MIDI or CV controlled instrument that you want to sample so you can
take the sounds with you on your blackbox. Maybe you just created a great sounding
patch on your eurorack and you want to capture that sound so you can use it again after
you change your patch. You may have a large synthesizer with a great sound but you
can’t fit it in your backpack. Blackbox’s automated multi-sampling helps you record these
instruments with just a little set up.
Recording a multi-sample pack starts out the same way as recording a single sample, but
you use the 1x button next to the grid icon to change to Multi mode. You will set up your
external instrument to play the sound you want and connect it’s audio and CV or MIDI
triggers to blackbox. Then you will need to set up a pad on blackbox as Multi-Sample
recording, and specify the range of notes, how many steps between samples, how many
velocity layers, and a few other options. Finally, you start recording and watch as blackbox
sends CV and MIDI signals out to trigger all of the specified notes and records each note
as a WAV file in a new folder on the microSD card. When finished, you will have a folder
full of WAV files that you can use as a multi-sample pack.
1.

First set up the external instrument you want to record. Connect it’s audio
output to the stereo audio IN jack on the back of blackbox.

2.

Set up the connections for blackbox to trigger the external instrument. You can
use MIDI or CV triggers. Blackbox will send out MIDI and CV signals while multisampling. You only need to connect one of them to the external device.
If you are using a MIDI trigger, connect a cable between either the USB MIDI
device or TRS MIDI out jack of blackbox to the MIDI input of the instrument to be
recorded. You may need to use the TRS to MIDI 5 pin DIN adapter included with
blackbox.
If you are using a CV trigger, connect the audio OUT 1 of blackbox to the CV and
Gate inputs of the instrument to be recorded. The CV signal will be sent on the
left channel, and the gate will be on the right channel of audio OUT 1. Use a TRS
splitter to break out the channels.

3.

Now configure the pad for recording. Push PADS and then select a pad in the
grid.

4.

Push INFO. If the pad is empty, you will see the WAV File Load and Record
screen. If the pad is loaded, you will see the WAV form screen.
If you are on the WAV form screen, touch the Pad mode icon to the right of the
Grid icon, and then select New Multi.
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5.

6.

At the top of the Load and Record screen, look at the
button to the right of the grid icon. It should say either 1x or
Mx depending on how you got to this screen. If it says 1x,
you are set up to record a single file. Touch the 1x button
and the Mode Selector menu will drop down. Touch Multi.
You are now in Multi or Mx mode. The list of recording
parameters changes to support this mode.
On the Recording screen, turn one of the top knobs to
select which parameter in the list you are editing, and you
use one of the bottom knobs to set the value for that
parameter. Select values for the following parameters to
configure your recording session:

Load and Record
Screen - Multi
Mode

Recording
Parameter
Rec Input
Gain

Description

Range of Values
L+R, Left, Right
-96.0 dB to + 20.0 dB

Filename

Choose which channel to record.
The VU meters above the list of parameters represent
the level of the signal to be recorded. You can adjust
the gain to get the desired level and avoid clipping.
The name of the folder that will store the multi-sample
bank recordings. It will also be used as a prefix for the
individual file names.

Select this parameter and then push the INFO
button to open the file naming screen. Turn a
knob to move the cursor position. Touch the
onscreen keyboard to enter a file name. Touch
Enter to save the filename and return to the
parameters screen.
The note that will be sent out as a trigger to record the C#-1 (1) through G9 (127)
first WAV file.
The note that will be sent out to trigger the last WAV C#-1 (1) through G9 (127)
file that will be recorded.

Start Note
End Note

Sample Every

Vel Layers
MIDI Chan
Note Length
Release Len

Rec Mon

How many semi-tones or notes are between each
1 through 16
WAV file recorded. Set to 1 to record a WAV file for
each note. Set to 12 to record one note per octave.
How many velocity layers should be recorded for
1 through 16
each note.
Select the MIDI channel that will trigger the instrument 1 through 16
to be recorded if you are using MIDI triggers.
In seconds, the length of time that the note gate will 1 through 60
be on.
In seconds, the length of time that recording will
1 through 15
continue after the note length is over. This will record
the tail of the note.
Controls when the incoming audio signal will be
On - the audio input will always be played.
played out through the blackbox outputs.
Auto - the audio input will only be played when
you are on the recording page for this pad.
Off - the audio input will never be played out.
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7.

When you are ready to start recording, push REC and Play together and sit back
and let the auto-sampler do its work. Blackbox will display which note it is
currently recording. Blackbox will display the Waveform screen when the autosampling is complete.

8.

You can push Stop to interrupt recording. Any completed recordings will still be
on the micro SD card. You can remove them with the Preset Clean command.
Keep in mind that if you have a folder full of WAVs that you recorded but that are
not used on any pads, blackbox will assume you do not need them and the
folder and its contents will be deleted when you Clean a preset.

Note:
► When the auto-sampling is complete, you will have a series of WAV
files in a new folder. The folder name will be \Presets\<preset
name>\<Filename>\<Filename>. See Manage WAV Files below for
more information about file organization.
► The WAV files will be named <Filename> + “-” + <MIDI Note Number> +
“-” + <MIDI Velocity>. For example, if your preset name is Pet Sounds
and your multi-sample filename is Cat Meows, an example file name
would be \Presets\Pet Sounds\Cat Meows\Cat Meows-036-100.
► Each WAV file will have the Root Note and Vel Layer parameters set
based on the MIDI Note used to trigger it. Blackbox will use WAV tags
to embed this information into the files.
► The pad used for recording will be changed to a Multi-Sample pad with
the new sample bank loaded.
► This feature will allow you to record up to 127 notes by 16 velocity
layers. Blackbox can only load 64 samples per pad--so choose your
sampling settings wisely. You can create multi-sample packs that can
be used on other devices that can take advantage of the additional
WAV files.
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Save and Load Parameters in WAV Files
There are several pad parameters that blackbox can read from and write to WAV files. These
parameters are:

Parameter
Root Note

Description
When you use Notes to play this sample, the base sample will play for
this root note. The sample will be pitch shifted up or down one semi-tone
for each note away from the root note. Blackbox will read the root note
from the WAV file, if available, when you add the WAV to the preset.
However, you can specify a different value here to be used for this WAV
on this pad in this preset.

Supported
Pad Modes
Sample
(Single and
Multi),
Granular

If you save the WAV file from this pad, the Root Note value will be saved
with it.
Stored in the WAV smpl tag.
LpStr

Point where the looping will begin when playing forward, or looping will
end when playing in reverse. Expressed in samples. Must be before or
equal to LpEnd.

Sample
(Single)

LpStr is read from the WAV file when sample is loaded, and saved to the
WAV file when the WAV is saved.
Stored in the WAV smpl tag.
LpEnd

Point where the looping will end when playing forwards, or looping will
begin when playing in reverse. Expressed in samples. Must be after or
equal to LpStr.

Sample
(Single)

LpEnd is read form the WAV file when a sample is loaded, and saved to
the WAV file when the WAV is saved.
Stored in the WAV smpl tag.
BeatCount

Enter the number of beats in the clip file to give blackbox more
information to work with when synchronizing playback to the current
song BPM.

Clip

Stored in the WAV acid tag.
Slice Points

The slice markers that are inserted into the file. Some other systems refer Slicer, Clip
to these as Cue Points.
Stored in the WAV cue points.
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Note:
► These parameters are saved in a format that is commonly used by
other music products. This means you can set these values in the other
product and then use them in blackbox, and the reverse.
► When blackbox first loads a WAV file that has parameters stored in it, it
will load the values of the parameters that are in the WAV, and use
default values for the other parameters. If you change a value of one of
these parameters for the pad, those changes only apply to this pad,
and are not automatically saved back to the WAV file. This allows you to
override parameters for specific pads.
► When loading a WAV file, blackbox makes an assumption about the
pad mode based on the parameters that are available in the WAV file. If
there are slices in the WAV, then it sets the pad mode to slicer. If there
are loop points in the WAV, then it sets the pad mode to sample.
To save the values you have configured for a pad back to the WAV
file:
1.
Open the WAV screen for the pad.
2.

Touch the name of the WAV file at the top of the screen to
display the WAV selection screen.

3.

Touch File and then Save or Save As. If you select Save,
blackbox will save the configured parameters into the same
WAV file you have loaded. If you choose Save As, you will
see the WAV file naming screen. Type in a new name to
save the changes to a different WAV file, and then touch
Enter to save. Blackbox will now load the newly modified
WAV file into the pad.

To revert back to the parameter and slice values stored in the WAV
file, simply reload the file into the pad.

WAV File Actions
Menu

Note:
► If you use an existing file name when you use Save As, the old file will
be overwritten with the current WAV file and parameters.
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Trim WAV Files
When recording new samples, you sometimes get some unwanted material at the start
or the end of the WAV file. Here’s how to trim the file:
1.

Open a pad with a WAV file you want to trim.

2.

Set the pad mode to Sample.

3.

On the WAV screen, turn the top left knob to set the left side of the pink bracket
to where you want the new file to begin. Turn the top right knob to set the
length of the pink bracket to be where you want the desired end point for the
WAV file.

4.

Touch the name of the WAV file at the top of the screen to display the WAV
Selection screen.

5.

Touch File and then Trim. Blackbox will ask if you want to
Trim and Save? Touch OK to overwrite the WAV file with
the portions outside of the pink bracket trimmed off. Touch
anywhere else on the screen to cancel.

6.

Save your preset to save the change to the pad. Otherwise,
the length parameter for the pad will be wrong when you
reload the preset.

WAV File Trim
Confirmation
Prompt

Note:
► You may want to use File -> Save As before you trim the file to give
yourself a backup copy of the file.
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Use Clipboard Functions with Pads
Blackbox has a slightly hidden set of clipboard buttons on the Pad
screen. You can use these buttons to Cut, Copy and Paste between
pads and to Clear a pad. To access these functions, turn the lower
right knob while on the Pads screen. The blue Velocity bar on the
right edge of the screen will be replaced with several clipboard
buttons. Select the pad you want to act on, then touch the button for
the desired action. Turn the lower right knob back the other way to
go back to the Velocity bar.

Edit Menu
Option

Pads Screen
with Clipboard
Side Panel

Action

Cut

Copy all of the WAV file references and parameter settings
for the selected pad and clear this pad. The copied
information is now in the clipboard for pasting into a
different pad. The current pad is now empty and all
parameters are set back to their default values.

Copy

Copy all of the WAV file references and parameter settings
from this pad. The copied information is now in the
clipboard for pasting into a different pad. The current pad is
unchanged.

Pste

Paste the pad information from the clipboard into the
selected pad. This pastes the WAV file references along with
all pad parameters.

Clr

Clear all WAV file references and parameter settings from
the selected pad.
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Manage WAV Files
Blackbox comes with hundreds of WAV files bundled with the firmware. You can load
WAV files into pads in order to add them to a preset. We talked about how to configure
pads previously in this document. Here we will discuss what tasks you can perform to
manage the WAV files themselves.

Working with WAV Files on the MicroSD Card
You can use the microSD card with your computer to manage the WAV files on the card.
You can load new WAV files onto the card or backup your existing WAV files for
safekeeping. Blackbox is compatible with all standard WAV files.
You can use a microSD Adapter to insert your microSD card into your computer. Then you
may use standard file techniques to rename the WAV files, reorganize them into
directories, delete them, copy them onto your computer or copy them onto other
microSD cards. We recommend that you occasionally make backup copies of your WAV
files, especially before upgrading to new firmware.
Blackbox supports organizing WAV files into folders and sub-folders. You can create your
own folder structure on the microSD card.
Blackbox 1.5 changes where new recordings are stored. When you create a new recording,
it will be stored in the folder for that preset. For example, the first new recording for the
My Kickin Grooves preset will be saved as \Presets\My Kickin Grooves\RC000001.wav.
When you load an existing WAV file into a pad, the preset will have a pointer to that WAV
file in its source folder. If you want to gather copies of all of the files for a preset into the
preset folder, use the preset pack option.
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Note:
► If you delete, move or rename a WAV file, it will no longer be available
for use by presets that were previously using it. The name of the WAV
file will still appear in the Preset, but the Waveform screen will be blank
until you load a new WAV file into the pad.
► Blackbox supports samples in the WAV file format. It supports 1 or 2
channel files with 16, 24 or 32 bit resolution at any sample rate. 48kHz is
the preferred sample rate.
► WAV file names may use Alpha Numeric Characters (A-Z, 0-9) and
some special characters. The following characters are NOT allowed:
“ / \ ? * < > : |
File names must be less than 256 characters, including the path name.
Files that do not conform to these naming constraints will not be
recognized by blackbox.
To Delete, Save As or Rename a WAV File:
1.
Touch a loaded pad on the Pads screen to display the Waveform Screen.
2.

Touch the name of the WAV file at the top of the screen to display the WAV Edit
screen.

3.

Use the control knobs to scroll to the WAV file or folder you want to delete. You
may need to load directories to navigate to the file you want to delete.

4.

Touch File to display the WAV File Actions menu.

5.

Touch Delete to delete the selected WAV file or folder from
the microSD card. Touch Save As to save a copy of the WAV
file with a different name. Touch Rename to change the
name of the file on the microSD card.

6.

If you select Delete, blackbox will display a confirmation
prompt. Touch OK to confirm, or touch anywhere else to
cancel.

7.

If you select Rename or Save As, blackbox displays the file
naming keyboard. Use the touchscreen to enter letters
using the keyboard. Touch the <-- to delete the previous
letter. Turn a knob to position the cursor. Touch Enter to
save your changes.

8.

Touch the back arrow <-- in the top left to exit the WAV Edit
Screen.

Page 56 of 106

WAV File Actions
Menu

File Naming
Keyboard

Copyright 1010music LLC 2021

Blackbox User Manual 1.7

Note:
► If you delete, move or rename a WAV file, it will no longer be available
for use by presets that were previously using it. The name of the
original WAV file will still appear in the preset, but the Waveform screen
will be blank until you load a new WAV file into the pad.
► To remove a WAV file from a pad without deleting the file, go to the
Waveform screen and touch the Pad Mode icon to the left of the file
name, and then touch New Recording. You can press PADS to go back
to the Pads screen without loading a file and the pad will be empty.

To Pack a Preset:
After you spend time carefully creating a preset, you don’t want to worry about it getting
broken if you make changes to that WAV file or re-organize your sample library. You may
also want to gather up all of the files used in a preset so you can move it to another
microSD card or archive it on your computer. The Pack feature was created to address
these needs.
1.

Load the preset you want to pack.

2.

Push PSET and then touch File->Pack. Blackbox will find all of the WAV files that
are assigned to pads and copy them into the folder for this preset. Multi-sample
banks will be copied to a sub-folder.
Note:
► If you continue to add WAV files to your preset after you pack it, the
preset will still point to these WAV files in their source folders. Pack the
preset again to copy these files over.
► If the Pack option is disabled, then the preset is fully packed already.
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WORK WITH KEYS
The Keys screens provide two alternative ways for you to play WAV files that have been
configured on the PADS screen. When you select a sample or clip pad to play with Keys,
blackbox will play the WAV file for that pad pitch shifted based on the triggered note. The
native sample will play with the root note, and it will shift up or down the appropriate
number of semitones based on the note you play. When you select a slicer pad to play
with Keys, blackbox will map the slices in the pad to the notes on the keyboard. When you
a use multi-sample pad with Keys, it will play the sample that has the root note closest to
the played note and then pitch shift as needed.
There are two Keys input modes. The first time you push the KEYS button, blackbox will
display a traditional black and white keyboard. Push KEYS again to toggle to the grid
keyboard. On the grid keyboard, you can trigger four octaves of notes within the scale
specified using Scale selection buttons at the top right of the screen, so you don’t have to
worry about scale specific sharps and flats. Use the arrow buttons at the top of the screen
to access additional octaves.
To Play a Sample, Clip or Granular Mode Pad With the Traditional
Keyboard:
1.
Push PADS to view the sample bank.
2.

Touch a pad or turn a knob to select the desired pad. The
pad will be pink when selected.

3.

Push KEYS once to display the Traditional Keyboard screen.
Touch the keys on the screen to play notes. You can slide
your finger across the screen to play adjacent notes.

4.

Touch the arrow buttons at the top of the screen or turn a
knob to scroll left or right one note or one octave. The
current octave label is displayed on each C note.

Keys

To Play a Sample, Clip or Granular Mode Pad With the Grid Keyboard:
1.
Push PADS to view the sample bank.
2.

Touch a pad or turn a knob to select the desired pad. The
pad will be pink when selected.

3.

Push KEYS twice to display the Grid Keyboard screen.
Touch the grid squares on the screen to play notes. You can
slide your finger across the screen to play adjacent notes.

4.

Touch the arrow buttons at the top of the screen to scroll up
or down one octave. The current octave label is displayed
on each root note.
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To Play Slicer Mode Pads With Keys:
You can use the Keys screen to trigger individual slices within a pad. Here is a basic
example of how to do this:
1.

Create a slicer pad and create 4 or more slices by either using the Scan feature or
manually creating the slices.

2.

Set the following values for the pad parameters:
Parameter

Value

Explanation

Launch
Mode

Trigger This will cause the WAV slice to play from beginning to
end when a trigger is received. Other values will work,
but let’s use this for the example.

Loop Mode

Off

We will turn off looping for this example.

Slice

3

This does not impact how the Keys screen plays the
slices.

Slice Seq

None

We will not use the Slice Sequencer in this example.

3.

Push KEYS to go to the Traditional Keyboard screen.

4.

Play C2 on the Traditional Keyboard screen. You will hear that slice 1 is played.

5.

Play D#2 and slice 4 will be played. Keys C2 and up are now mapped to Slices 1
and up for playback.

6.

Push KEYS again to go to the Grid Keyboard screen.
Blackbox will display numbered squares in the grid for each
slice in the WAV file. Use the arrows at the top of the screen
to access additional octaves.

7.

Touch a numbered square on the grid to play that slice.

8.

Touch STOP at the top of the screen to stop playing all
slices. (The SLICE button next to the STOP button does not
do anything. It is just a reminder that this is a slice pad.)
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Note:
► On the traditional keyboard, the last slice will be played for all notes
above the last slice. Nothing will play for notes below C2.
► If you use the Grid-based keyboard with a slicer pad, the slices are
mapped to the notes available in the selected scale.
► The steps above show a simple example of using Keys alone to trigger
different slices within one pad. You can use this with Loop Mode ON
with Launch Modes of Gate or Toggle to achieve different effects. You
could also use this with Slice Seq if you want to have the Slice Seq
control what slices play when a pad trigger is received.

To Select a Scale on the Grid Keyboard:
1.
Push the KEYS button until you see the Grid keyboard.
2.

Touch the left Scale Selector button to display a list of
values for the Root Note. Touch an option to select it.
Alternatively, you can turn any knob while on the grid
keyboard to change the Root Note.

3.

Touch the right Scale Selector button to display the Scale or
Mode options. Turn any knob to scroll through the values.
Touch the screen or any button when the desired value is
displayed.

Grid with Scale
Mode Selector

Note:
► To find the right key to match some music, tap a root note on the grid
while turning a knob to scan through the root notes.
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WORK WITH SEQUENCES
Now that you have some samples selected, you can record some
sequences. When you press SEQS you will see a grid of sequence
cells. Each cell displays a mini piano roll view of the sequence. You
can reuse a pad in multiple sequences if you choose. You can use
more than one pad in each sequence. You can also use the Keys
screen to trigger the pads while recording sequences. You can
choose which sequences you want to play while you are recording
other sequences, and which sequence cell you want to record into.
You can have multiple sequences playing at one time. Sequences
can start and stop independently based on their quantization
settings.

Sequences Grid

On the sequences screen, the currently selected sequence is pink. Any active cells have a
white border around the cell. Touch a cell to toggle the active state of the sequence. The
context display at the top of the screen (e.g. Seq 3 or Section 1) displays the current
recording context for blackbox. When not in Song Mode, this context display will indicate
the sequence you are recording or editing, and the blue progress bar in the top right
displays the current playback state of the sequence that has context.
When a sequence is queued up to play at the next quantization break, a white rectangle
appears at the bottom of the sequence cell. When a sequence is actively playing that
white rectangle is replaced with a blue progress bar.
If you have a MIDI sequence from another device in a MID file, you can import that file
into a sequence for use on blackbox.

Record and Play Sequences
Before we dive into the details of working with Sequences, make sure Song Mode is
disabled because you cannot record sequences when you are in Song Mode.
To Toggle Song Mode On and Off:
1.
Push the SONG button below the screen.
2.

Touch the on-screen Song button if needed to disable Song Mode. The Song
button is blue when enabled, and gray when disabled. The context display at the
top of the screen will be updated to display the current sequence number (when
disabled) or song section (when enabled).

Copyright 1010music LLC 2021

Page 61 of 106

Blackbox User Manual 1.7

To Record a Sequence:
1.
Push SEQS to see the sequences grid.
2.

Touch a cell or turn a knob to select a sequence cell. The selected sequence cell
will be pink. The context at the top of the screen will now display the number of
the selected sequence.

3.

Push PADS or KEYS to play the sequence to be recorded. You can also trigger
pads using an external MIDI device.

4.

Hold down the REC button while you push PLAY to start recording. If you have
the global Lead In option set to ON, blackbox will wait four beats, then start to
play any active sequences and start recording.

5.

Touch pads or keys to add notes to the sequence you are recording.

6.

Push REC to continue playing but stop recording. Push STOP to stop recording
and stop playing the loop.
Note:
► While recording, the sequence will record to the length specified in the
sequence parameters, and then loop back and play what has been
recorded. You can then layer additional notes into the sequence if you
continue to play.
► Any active sequences will play while you are recording. However, the
notes from other sequences will not record into the currently selected
sequence. Only the notes you trigger on the PADS screen, the KEYS
screens or via external MIDI devices will be added to the sequence.
► You can push REC while another sequence is playing to start recording
immediately into the selected sequence.

To Play Sequences:
1.
Push SEQS to see the sequences grid.
2.

Touch sequence cells to toggle their active state. Active sequences have a white
frame. You can play multiple sequences at once.

3.

Push PLAY to start playing the active sequences.
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4.

Touch sequence cells to turn them on or off. The cells start and stop in alignment
with the sequence quantization settings. A blue progress bar shows the current
playback state of the sequence. A white progress bar indicates that the
sequence will start at the next quantization break.

5.

Push STOP when you are finished. If some WAV files remain playing, you can
push STOP again to turn them off.
Note:
► Some sequences trigger long WAV files. These WAV files may still be
playing after the sequence stops.
► Some sequences use toggle mode to trigger WAV files. It’s possible to
stop a sequence between the toggle on and the toggle off notes,
leaving the WAV still playing after the sequence stops.
► You can record a sequence while others are playing. Simply push REC
in this case to start and stop recording. You can even switch which
sequence you are recording into without pushing STOP.

To Edit and View the Notes and Pad Triggers in a Sequence:
You can use the INFO button with a selected sequence cell to view and edit the sequence.
1.
Touch a sequence cell to select it.
2.
Push the INFO button to drill into that cell. Blackbox will
display the sequence editor Piano Roll screen. If you
recorded the sequence using KEYS, the piano roll view will
have a keyboard representing the scale along the left side
of the screen. In Pads Mode, the left edge lists the pad
numbers. The piano roll displays the notes or pads recorded
Piano Roll Keys
for each step over time moving from left to right. You can
View
touch the view mode button at the top of the screen to
switch view modes between KEYS and PADS.
3.

If you recorded Keys input for more than one pad, you can
select the pad to view and edit in the piano roll by touching
the grid icon in the top right in KEYS view, then touching
the cell for the desired pad.

4.

You can use the control knobs and touch gestures to adjust
notes and to zoom and scroll through the sequencer:
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Action

Result

Turn the top left control
knob

Cycles the note selection through the notes
on the piano roll

Turn the top right control
knob

Changes the length of the currently selected
note

Turn the bottom left control Moves the note left or right to change the
knob
timing of the note.
Turn the bottom right
control knob

Moves the currently selected note up or down
through the piano scale. (Only works in KEYS
View.)

Two finger pinch or stretch

Zooms the piano roll in or out

Single finger drag or swipe

Scrolls the piano roll

Note:
► When the Sequencer Screen reloads, it zooms horizontally to display
the number of steps that have been selected in Step Count, and scrolls
vertically to display the entered notes.
► The note position is restricted to the Step Count configured for this
Sequence.
► When recording, the sequencer will add the incoming notes to the
sequence. It will not remove previously existing notes. Touch Clear
before touching REC if you want to start with a clean piano roll.
► The C notes on the piano roll are numbered to indicate which octave is
currently displayed. If you zoom out too far the numbers will not be
displayed.
► The numbers across the top of the piano roll indicate the step
numbers. If you zoom out too far the numbers will not be displayed.
► To quickly switch the sequence you are editing, touch the grid icon at
the top left corner of the screen and then touch the square in the
selection grid that corresponds to the sequence you want to edit.
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To Copy and Clear Sequences:
You can use standard clip board style functions to cut, copy, paste,
and clear sequences.
1.

Push SEQS to display the Sequences Grid.

2.

Touch a sequence or turn a knob to select a sequence.

3.

Push the INFO button to display the Piano Roll screen.

4.

Touch EDIT at the top of the Piano Roll screen to display the
clipboard functions menu.

5.

Touch a menu option to perform the action described
below.

Edit Menu
Option

Piano Roll Edit
Menu

Action

Cut

Copy all of the notes and pad triggers and parameter
settings in this sequence and clear the piano roll of this
sequence. The cut information is now in the clipboard for
pasting into a sequence.

Copy

Copy all of the notes and pad triggers and parameter
settings in this sequence. The copied information is now in
the clipboard for pasting into a sequence.

Paste

Paste the sequence information from the clipboard into the
current sequence. Pasting is an additive action. This means
that it only adds notes and pad triggers to the piano roll. It
doesn’t remove them. This can be useful to merge two
sequences together. Keep in mind that the sequence
parameters are also copied along with the note and pad
events.

Clear

Clear all note and pad trigger information from this
sequence. All parameter settings remain untouched.
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To Edit Sequence Settings:
Each sequence cell has sequence parameters to control the length of the steps, the
length of the sequence, quantization, duty cycle and MIDI Output channel.
1.

Push SEQ and touch the sequence cell you want to edit.

2.

Push INFO twice to display the sequence parameters page. Push INFO again to
cycle through additional parameter pages and the piano roll view.

3.

Use the control knobs to adjust the values of the sequence parameters:
Parameter
Step Len

Description
Controls the length of time the sequence
will spend on each step, in terms of fractions
of a bar.

Range of Values
1/64, 1/32T, 1/32, 1/16T, 1/16,
1/8T, 1/8, 1/4T, 1/4, 1/2T, 1/2, 1
bar, 2 bars, 4 bars, 8 bars
(T = Triplet)

Step Count

The number of steps in the sequence

1 to 28

Duty Cycle

The duration of the note events, where is 0%
is inaudible, and 100.0% is playing the full
duration of the note.

0% to 100%

MIDI OUT

The MIDI Channel that this sequencer will
use for output

None, Ch1, through Ch 16

Quant Size

Defines precisely when to start the
sequence. When a sequence is activated or
deactivated, blackbox will wait until the start
of the next Quant Size interval to start or
stop the sequence.

1/64, 1/32T, 1/32, 1/16T, 1/16,
1/8T, 1/8, 1/4T, 1/4, 1/2T, 1/2, 1
bar, 2 bars, 4 bars, 8 bars

Step Mode

(T = Triplet)

Step Mode controls whether the sequence
ON, OFF
notes are quantized to the grid while
recording. When Step Mode is OFF, recorded
notes will no longer be quantized to the grid.
Use Step Mode ON to force your notes to the
quantization points for tight alignment to
the tempo. Use Step Mode OFF for more
natural sounding and free flowing notes.

Note:
► If a value of a sequence parameter is changed during playback of the
sequence, the change will take effect at the start of the next loop
through the sequence.
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To Use Sequence Quick Action Buttons:
On the sequences screen, there are a few buttons along the right side to allow quick
access to some actions.
Sequencer
Button
UNDO

Result
Rolls back the last of round of changes to the notes and pad
triggers added to the selected sequence. Any notes or pad
triggers added since the last time you pressed REC will be
removed from the sequence.

CLEAR

Clears all notes and pad triggers from the selected
sequence. Sequence parameters remain unchanged.

OFF

Deactivates all sequences.

To Adjust Probability and Velocity for Note Events:
Sequence loops can get boring if they are repeated for too long. You can add some
interest to them by adjusting the probably of playback to individual note or pad events in
a sequence. You can also add some more interest to your sound by adjusting the
playback velocity. By default, Velocity is configured as a modulation for the Level
parameter for all pads. This means at lower velocities, the pad playback level will be lower.
Additionally, multi-sample pads may have WAV files that are triggered at different
velocities. WAV files are mapped to different velocities either during automated multisample recording on blackbox, or in an external WAV file editor.
When recording a sequence, blackbox will capture velocity values used during the
recording from either MIDI Velocity or the Velocity touch control on the right side of the
PADS screen. You can adjust the velocity as well as the probability of note playback as
follows:
1.

Push SEQS to go to the Sequences screen.

2.

Select a sequence and push INFO to display the sequence
Piano Roll screen.

3.

Touch Event at the top of the screen to enable the Event
editor. The Event button will turn blue and you will see the
VEL and PLAY parameters for the selected note at the
bottom of the screen.

4.

Turn the top left knob to select the note to be edited. The
selected note is pink.
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5.

Turn the bottom left knob to adjust the velocity for the selected note event. The
VEL parameter in the bottom left corner of the screen shows the current value.

6.

Turn the bottom right knob to adjust the probability of playback for the selected
note event. The PLAY parameter in the bottom right corner of the screen shows
the current probability.

7.

Touch the Event button again to disable note event parameter editing so you
can use the knobs to move and change the length of notes.
Note:
► You can use the Event editor in both PADS and KEYS mode on the
Piano Roll screen.
► If a value of a note event is changed during playback of the sequence,
the change will take effect at the start of the next loop through the
sequence.

To Import a MID file into a Sequence:
If you have a MIDI sequence you created in your DAW or another
device, you can use a .mid file to import the sequence into blackbox.
The sequence will be a KEYS sequence and will play with the
1.

Push SEQS to go to the Sequences screen.

2.

Select a sequence and push INFO to display the sequence
Piano Roll screen.

3.

Make sure the piano roll is in Keys mode. If the mode
selector at the top left says PADS, touch PADS and then
KEYS to change the mode.

4.

Touch the pad selector grid at the top right and then touch
a cell in the grid to choose which pad will play the
sequence.

5.

Touch Edit at the top of the screen to open the Edit menu.

6.

Touch Import and then select a .mid file to import.

7.

Use the knobs to scroll through files and folders. Touch the
caret ^ button and the Load button to navigate through the
file folders. Select the file to import and then touch Load to
import the sequence. The sequence will now include the
note events imported from the MIDI file. You may need to
use the pad grid selector to select the pad and see the
notes.
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8.

Push INFO to see the Sequence Parameters screen. Adjust the Step Length and
Step Count to match the imported sequence if needed.
Note:
► Blackbox will only import the first track in a MIDI file.
► The sequence will be mapped to the pad selected in the pad grid at the
time of import. You can use Copy and Paste to move it to a different
pad if needed.
► If the imported sequence is longer than the number of steps
configured for the sequence, only the steps in the sequence length will
play back.
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WORK WITH SONG SECTIONS
Once you have a few sequences set up, you can use Song Mode to record song sections.
When Song Mode is enabled, you will record into the currently selected song section.
While recording a section, you can record turning sequences on and off over time. You
can record multiple sections to playback as a complete song. You can have up to 16
sections in a preset. Swipe the touch screen to scroll up and down through the list of
sections.
To Toggle Song Mode:
When you create a new preset, by default Song Mode is turned off. This means that
blackbox is recording and playing sequences. Song sections are ignored in this mode.
When you enter Song Mode, you can now record into and playback song sections. To
toggle Song Mode on or off:
1.

Push the SONG button below the screen.

2.

Touch the Song button at the top of the screen to toggle
Song Mode. Song Mode is enabled when the on-screen
button is blue.
Song Screen

Record and Play Song Sections

When Song Mode is enabled, the currently selected section will play when you push the
PLAY button. Any active sequences will also play. You can quickly deactivate all sequences
by touching the DEACT button on the sequences screen.
To Record a Song Section:
1.
Enable Song Mode as described above.
2.

On the Song screen, turn the top left knob to adjust the BPM or tempo of the
song. This number is displayed to the left of the Edit button.

3.

Select the song section you want to record into.

4.

Push INFO to display the section parameter screen. Here you can set the length
of the song section in bars. The maximum length allowed is 32 bars.

5.

Push SEQS to display the sequences screen. Activate the sequences you want to
have playing when you start recording the song section, and deactivate those
you don’t want.

6.

Hold down the REC button while pressing PLAY to start playing and recording
the active sequences.

7.

Touch sequences to activate and deactivate them over time.

8.

Push REC to stop recording but continue playback. Push STOP to discontinue
playback and recording.
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Note:
► Each time you record a song section, you add to the current song
section. Any previous sequence actions are still there. If you want to
start over again with a clean section, select the song section, then
touch Edit and Clear.
► Song sections record on and off events for sequences. If you change a
sequence, you will also change the song section.
► Song sections do not record pads or keys actions.
► You can modify the BPM at any time to adjust the playback speed of
the song sections and the sequences.
► When in Song Mode, the context display at the top of the screen shows
the name of the active Song section, and the progress bar to the right
of that displays the progress of this section.
To Play Song Sections:
1.
Push SEQS to display the Sequences screen. Activate the sequences you want to
have playing along with the song section, and deactivate those you don’t want.
2.

Push SONG to view the Song screen and then touch the song section you want
to start playing. The selected section will be pink.

3.

Touch the SONG button at the top of the screen to turn on Song mode. The on
screen Song button will be blue when active.

4.

If you want the selected section to play in a loop, touch the Loop button at the
top of the screen to enable it. If Loop is disabled, blackbox will play all
subsequent song sections in order when the current section ends.

5.

Push the PLAY button and blackbox will start playing the selected song section
along with any active sequences.

6.

You can jump around between song sections by touching the next section you
want to play. That section will start to play at the beginning of the next bar.

7.

You can toggle Loop mode while a song section is playing to stay with a section
for a while and then let it fall through to the next section at the end of the
current loop.
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Note:
► You can play additional sequences during song section playback by
activating them on the sequence screen.
► You can play pads and keys on top of song sections that are playing.

To Edit Song Sections:
The Edit menu on the Song screen allows you to perform basic clipboard operations and
to rename the section.
1.

On the Song screen, select the song section you want to edit.

2.

Touch the Edit button at the top of the screen. The Edit menu will be displayed.

3.

Touch the menu item for the action you want to perform:
Edit
Menu
Option

Action

Cut

Copies a song section and remove it. All sequence events, the section name and
the section length will all be copied. The information is held in the clipboard for
pasting.

Copy

Copies a song section. All sequence events, the section name and the section
length will all be copied. The information is held in the clipboard for pasting.

Paste

Pastes the section information in the clipboard into the selected section. All
information in the target section will be replaced.

Clear

Clears all sequence actions from the selected song section and resets the
section length back to 32 beats.

Add

Inserts a new song section below the selected song section.

Rename

Displays a virtual keyboard where you can rename the section. Touch enter at
the bottom of the screen when you are ready to save the changes.

Delete

Deletes the selected song section

To Reorder Song Sections:
1.
Add a new song section where you want the section to be.
2.

Select the section you want to move and touch Edit then Cut.

3.

Select the new song section you added in step 1 and then touch Edit and Paste.
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To Change the Tempo of a Song:
1.
Push the Song button.
2.

Turn the top left knob. The BPM display in the top left will update as you turn the
knob and the song playback speed will change in real time. The default is 120
BPM.

To Add Swing to a Song:
Swing is a feature that makes electronic music sound more like a live performance. The
swing setting in blackbox controls the relative timing of even numbered 1/16 notes
compared to the notes on either side of them. When the swing setting is set to the
default of 50%, the even 1/16 notes occur in their metered place halfway between the
notes on either side. When the number is less than 50%, the even 1/16 notes shift closer in
time to the previous note. When the number is above 50%, the even 1/16 notes shift closer
in time to the following note.
1.

Push the SONG button.

2.

Turn the top right knob. The Swing setting display to the right of the BPM will
update as you turn the knob and the song playback will change in real time. The
default swing amount is 50%.

Note:
► Your sequence must have a step size of 1/16 or smaller for Swing to take
effect.
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APPLY EFFECTS
Blackbox has two effects that can be applied to as many pads as you want. You apply an
effect by selecting the send amount for the pad for each of the desired effects (FX1 or FX2)
and then configuring the parameters for that effect. After the effect is applied, the wet
signal is routed to Audio Out 1. All pads will get the same parameter values for an effect.
To Route a Pad to an Effect:
1.
Push the FX button to go the FX Screen.
2.

On the FX screen, select the pad that you want to use.

3.

Turn the top left knob near FX1 to set the FX1 send amount
for the pad. This is the amount of the signal from this pad
that you want to send to FX1 for effects processing. You can
also use the touch screen to slide the level selector next to
the knob to the desired position. When a pad is sending
some of its signal to FX1, a blue triangle is displayed in the
top left corner of the pad. You can repeat this step for FX2
and a blue triangle will appear in the top right corner of the
pad.

FX Screen

To Modify Effect Parameters:
1.
Push the FX button to display the FX screen.
2.

Touch the FX1 or FX2 box in a lower corner of the screen to select it. The currently
selected effect is highlighted pink.

3.

Push INFO to display the effect parameters screen for the selected effect.

4.

Turn the knobs to adjust the effect parameters. You will hear the impact of the
parameter changes in real time. Here are the available effect parameters:
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Effect
FX1 =
Delay

Parameter Settings
Delay

Mod
Target?

Determines the delay length. When Beat Sync is On,
delay is specified in musical intervals:

Yes

1/64, 1/32, 1/16, 1/8T, 1/16D, 1/8, 1/4T, 1/8D, 1/4, 1/2T, 1/2, 1 bar
When Beat Sync is Off, delay is specified as a
percentage from 0% to 100%.

FX2 =
Reverb

Feedback

0 to 100%. Determines the amount of regeneration or
echo in the delayed signal.

Yes

Beat Sync

Controls whether the delay is measured in musical time No
intervals or percentage.

Decay

0 to 100%. Determines how long the reverberation will
ring out.

Yes

Damping

0 to 100%. Sets the amount of damping that is applied
to the reverb. Higher values will make the reverb end
sooner.

Yes

Predelay

0 to 100%. Sets the amount of delay in the signal before
the reverberation is applied. In real life, this is related to
how close the sources is to the walls.

No

Note:
► The same effect parameter values are applied to all pads that are
sending signals to that effect.
► The Reverb effect is very processor intensive. Blackbox does not limit
what you can do based on anticipated processor needs. As a result, it is
possible to overdrive the processor, causing crackling and drop outs.
See Processor Management Tips below for more information about
preventing sound artifacts.
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ADJUST THE MIX
On the Mixer screen you can independently adjust the volume and pan of each pad. The
number on the pad represents the dB level of the audio output. The bar at the bottom of
the grid cell represents the pan position for the pad. Pan is only available if the pad is
routed to a stereo output. When the pan line is in the middle, the output is balanced
equally between left and right. A solid blue bar below the sound level indicates a pad is
actively playing. A red bar at the top of a cell indicates that pad is muted.
To Adjust the Sound Level and Pan of a Pad:
1.
Push MIX to display the Mixer screen.
2.

Touch the cell you want to adjust.

3.

Turn one of the top two knobs to adjust the level of the
currently selected pad.

4.

Turn one of the bottom two knobs to adjust the pan, if
available.

Mixer Screen

Note:
► You can hear adjustments to pan and volume in real time when a
sequence or pad is playing.
To Mute and Unmute Pads:
The mixer screen also allows you to mute individual pads.
1.

Push the INFO button on the Mixer screen to enter Mute
mode. In this mode, active pads have a green background
and muted pads have a red background.

2.

Touch a pad while in Mute mode to toggle it’s mute state.

3.

Push INFO again to go back to controlling level and pan.
Any muted pads will have a red bar across the top of the
pad.

Mixer Screen in
Mute Mode

Note:
► Mute is useful if you want to use a pad to drive an external MIDI device
when the device is available, but play a pad when it’s not. Muted pads
still play out over MIDI.
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MANAGE PRESETS
Blackbox stores a set of pad configurations, sequences and song sections as a preset. You
can save as many presets as you want, as long as there is room for the files on your
microSD card. When you turn on blackbox, it automatically loads the most recently used
preset on this microSD card. The microSD card that comes with blackbox has about 60
presets and corresponding WAV files loaded.
When blackbox loads a preset, it loads the set of WAV files and configured parameters for
each pad, sequence and song section saved in the preset. Review the loaded presets to
see some examples of blackbox features in action. The presets that are loaded on
blackbox use only a fraction of the WAV files that are available on the microSD card. You
can use the microSD card to load your own WAV files into blackbox, as well as record new
ones. Blackbox also enables you to customize and create your own presets.
Presets are saved on the microSD card when you choose to save them. If you load a
different preset without first saving the current preset, you will lose your work. If you
change to a different microSD card, you will have a different set of presets. When you
switch to a different preset, all previous settings will be replaced with the settings of the
newly selected preset, which may be blank.
Blackbox stores all of the preset xml files in sub-folders under the \Presets folder. Each
preset has its own sub-folder with the name of the preset, and a preset.xml file within
that sub-folder. E.g. the preset My Kickin Grooves will be stored as a file named
preset.xml in the \Presets\My Kickin Grooves folder. When you first start working with
the preset, it will point to the WAV files in their source folders. The Pack function will copy
all of the used WAV files into the preset folder.
When you create a new recording, blackbox stores it in the folder for that preset. For
example, the first new recording for the My Kickin Grooves preset will be saved as
\Presets\My Kickin Grooves\RC000001.wav.
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Note:
► All of the preset folders are gathered under one \Presets folder at the
root.
► Before you Pack a preset file, the .xml file lives in its own sub-folder
under \Presets which is created as soon as you create a preset, but the
WAV files stay in their source folders until you pack them.
► Blackbox will automatically move a legacy preset into the new folder
location the first time you load that preset after upgrading to the 1.5 or
newer firmware. You may then use the Pack function to consolidate all
of the files used by the preset into the preset’s folder.
► All presets have a file named preset.xml under the folder that has the
name of the preset. This file contains all of the settings for this preset.
► We covered how to Create a New Preset earlier.
► Presets are not saved automatically in the background. This ensures
that you don’t make unintended changes to a preset.

To Save Changes to a Preset:
By now you may have added a few pads to your preset and spent some time configuring
them. If you want to keep the results of your efforts, you will need to save the preset.
Blackbox does not automatically save changes as you work. If you change to a different
preset or unplug blackbox, you will lose your work.
1.

Press PSET to display the Preset Management screen.

2.

Touch File to display the Preset File Menu.

3.

Touch Save to store your changes to the currently loaded
preset.
Preset File Menu
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To Load a Preset:
1.
Press PSET to display the Preset Management screen.
2.

Use the knobs to scroll through the list of presets. The blue highlight indicates
the currently selected preset.

3.

Touch Load to load into blackbox the information that was previously saved for
this preset. The only values that are not stored in each preset are the values on
the TOOLS pages. These are global settings that apply across presets and are
stored separately on the microSD card.

To Pack a Preset:
After you spend time carefully creating a preset, you don’t want to worry about it getting
broken if you make changes to that WAV file or re-organize your sample library. You may
also want to gather up all of the files used in a preset so you can move it to another
microSD card or archive it on your computer. The Pack feature was created to address
these needs.
1.

Load the preset you want to pack.

2.

Push PSET and then touch File->Pack. Blackbox will copy all of the WAV files
used by this preset into this preset’s folder. Any multi-sample banks will be
copied with their folder. The preset.xml file will be updated to point to these
copies of the WAV files and will be saved.
Note:
► If you continue to add WAV files to your preset after you pack it, the
preset will still point to these WAV files in their source folders. Pack the
preset again to copy these files over.
► If the Pack option is disabled, then the preset is fully packed already.
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To Clean unused WAV files out of a Preset’s folder:
If you change which WAV files are loaded in your Pads, you may want to remove any
unused WAVs from the preset folder.
1.

Load the preset you want to clean.

2.

Push PSET and then touch File->Clean. Blackbox will prompt you to confirm
“Del Unused WAVs?” If you choose OK, blackbox will search the preset folder for
any WAV files that are not mapped to pads in this preset. Any WAV files in this
preset’s folder that are not used by pads in this preset will be deleted. Blackbox
will save the preset.xml file as part of this process.
WARNING: this action cannot be undone. You can touch anywhere besides OK
to cancel this operation..

To Delete a Preset:
When you delete a preset, you remove the preset from the list of presets on the Preset
Management Screen, and you delete the corresponding XML file from the microSD card.
You cannot undo this action. To delete a preset:
1.

Push the PSET button to view the Preset Management
screen.

2.

Use the control knobs to scroll through the list of presets.
The blue highlight indicates the currently selected preset.

3.

Touch File to display the Preset File Menu.

4.

Touch Delete to delete the highlighted preset. Touch OK to
confirm the delete, or touch anywhere on the screen to
abort the operation.

Preset
Management
Screen

WARNING: this action cannot be undone. You can touch
anywhere besides OK to cancel this operation..
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To Rename a Preset:
1.
Push the PSET button to view the Preset Management screen.
2.

Use the control knobs to scroll through the list of presets. The blue highlight
indicates the currently selected preset.

3.

Touch File to display the Preset File Menu.

4.

Touch Rename to display the keyboard screen.

5.

Touch the back arrow <- to erase the preset name or turn a knob to position the
cursor where you want type. Then use the onscreen keyboard to type in a new
name. Use the caret button ^ to toggle between upper and lower case letters.
Touch the 123 button to display the numeric keyboard if needed. When the
name is complete, touch Enter to save the name and return to the Presets
screen with the preset selected.
Note:
► Renaming a preset does not load that preset.

To Save Current Changes as a New Preset:
Sometimes while working on a preset, you decide to save your changes to a different
preset in order to save your work while still preserving the original preset state.
1.

Push the PSET button to view the Preset Management screen.

2.

Touch File to display the Preset File Menu.

3.

Touch Save As. Blackbox displays a touch screen keyboard you can use to enter a
new name. Touch the Enter button to save the changes and go back to the Pads
screen with the renamed preset loaded.

Note:
► If you enter a name that is already in use, you will replace the old file
with the current preset.
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Work with Preset Files on the MicroSD Card
Preset files can be backed up on your computer or shared with other blackbox users. The
presets are saved as XML files on the microSD card. Each preset is saved in a preset.xml
file in a folder with the name of the preset under the \Presets folder. For example, a
preset named April Gig will be stored as \Presets\April Gig\presets.xml. If you have
packed a preset, all of the WAV files for that preset will be stored in the preset’s folder.
You can use a microSD Adapter to insert your microSD card into your computer. You can
then use standard file techniques to rename the preset folders, delete them, copy them
onto your computer or copy them onto other microSD cards. We recommend that you
occasionally make backup copies of your presets, especially before upgrading to new
firmware. Keep in mind that if you move a preset file to another microSD card, it will only
work properly if the WAV files needed for that preset are on the new card in the same
directory structure. The Pack function makes that much easier.
Note:
► Blackbox stores all presets in self named folders under the \Presets
folder. Blackbox will not find them if you move the XML files outside of
these folders or move these folders outside of the \Presets folder.

Legacy Presets
Blackbox Firmware version 1.5 changed the way presets and new sample recordings
are managed. In older versions, the preset files were stored in the root folder, but
now the preset files are in individual folders under the \presets folder. New WAV file
recordings also used to be stored in the root folder and are now stored in the
preset’s folder. What if you have some legacy presets on your microSD card?
What will happen to my legacy presets? How do I convert them to the new file
structure?
When you load presets, blackbox will display a single list with all presets stored at
the root and all presets stored under the \Presets folder. The files will be in
alphabetical order by file name, independent of where they are stored. Each time
you open a preset that is stored in the root, blackbox will create the preset folder for
this preset and move the preset into that folder. In this way, as you open the presets,
they will be migrated to the new structure one at a time. You can then use the
File->Pack feature to collect all of the WAV files used by this preset into the
corresponding sub folder. Any new recordings you make will be stored in the preset
sub folder.
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When will my legacy WAV files get cleaned out of the root folder?
We won’t move them automatically. We recommend that you pack up all of your presets
one by one, which will copy all of the files used by the presets into their respective folders.
When that is done, you may choose to delete the files that are stored at the root or safely
move them to a sub folder for future use.

Copyright 1010music LLC 2021

Page 83 of 106

Blackbox User Manual 1.7

TOOLS
The Tools screen is the home for global parameters that apply across
presets. This is where you can adjust the Headphone volume and
control the metronome. Push INFO or touch the page buttons along
the bottom of the screen to cycle through the available parameter
pages. Turn a knob to adjust the value of the nearest parameter.
Tools Screen

Settings on the Tools Screen:
Page
Main

Rec

Parameter Description
Brightness

Controls the brightness of the display screen.

Headphone

Controls the volume of the signal going to the headphones.

Compressor

When set to On, blackbox will apply a compressor to the signals sent to Out 1.

RecToPlay

When set to ON, blackbox will automatically start to play the new sample when
recording ends if the Length parameter was used for recording.

RecConfig

When set to Global, changes made to recording settings on the Pad Loading
and Recording screen will apply to all empty pads.
When set to Per Pad, these changes only change the current pad and do not
change what is used for other empty pads. Use Per Pad when you want to set
up a Template preset with different recording configurations for each pad.

MIDI In

Lead In

When set to ON, blackbox will wait 4 beats before recording begins. It will
display the count down as a negative number in the measure counter in the top
left of the screen.

MIDI Pads

Specifies which MIDI channel is used to trigger pads and sequences. If a channel
selected here is also chosen as the MIDI IN channel for a pad, that pad will also
play notes in response to signals received on this MIDI channel. See the section
Use MIDI Devices with Blackbox below for more information.
When set to Omni, pad hits and sequences can be triggered by all MIDI
channels. However, any MIDI channel that is assigned as the MIDI In for a pad or
as the MIDI Keys parameter will be excluded from the list of channels that will
trigger pad hits.
MIDI Program Change messages received on this channel will be processed by
the blackbox if the ProgChange parameter is set to ON.
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Page
MIDI In
(Cont’d)

Parameter
MIDI Keys

Description
Specifies which MIDI channel is used to play notes for the currently selected
pad. If a channel selected here is also chosen as the MIDI IN channel for a pad,
that pad will also play notes in response to signals received on this MIDI
channel. See the section Use MIDI Devices with Blackbox below for
more information.
When this parameter is set to Omni, notes will be triggered for the currently
selected pad by all MIDI channels. However, any MIDI channel that is assigned
as the MIDI In for a pad or as the MIDI Pads parameter will be excluded from
the list of channels that will trigger notes for the currently selected pad.
MIDI Program Change messages received on this channel will be processed
by the blackbox if the ProgChange parameter is set to ON.

ProgChange

When set to ON, blackbox will respond to MIDI program change messages
received on the MIDI Pads and MIDI Keys channels by opening the Preset that
maps to the specified program number. See the section Use MIDI Devices
with Blackbox below for more information. Program change messages on
other channels will be ignored.
Remember that blackbox does not automatically save changes. This means
that when you change presets using a MIDI Program Change you will lose any
unsaved changes.

Metro

Clock

ClockSource

Allows you to select a source for the clock signal when you have one or more
MIDI devices connected to blackbox. Select MIDI Port to use the device
connected via the TRS MIDI In port. Choose USB Port to use the device
connected via the USB Device port. Select All when you only plan to have one
device with a clock connected at a time and don’t want to have to keep
changing this parameter, or you want to let the two clocks fight it out. Select
None to ignore all incoming clock signals and always use the internal signal.

Metronome

Controls when the metronome is used. Select OFF to disable the metronome
completely. Choose Rec to only use the Metronome when you start recording.
Choose Play to use the metronome whenever the Play button is active.

Output

The metronome will only play on the audio output channel selected here. You
can choose to play it on Stereo outs Out1, Out2 or Out3, or only the left or right
channel of any of those outputs. You can also choose to send it to the
headphones output by selecting HP. If you choose any channel other than HP,
the signal will not be included in the headphone output.

Gain

Adjusts the volume level of the metronome in decibels.

Clock In

Controls how the signal received in the Clock In TRS jack is interpreted. Set
this to the number of pulses per quarter note that are generated by the
external clock source.

Clock Out

Controls the clock signal sent out through the Clock Out TRS jack. Set this to
the number of pulses per quarter note expected by the external device that
will receive the clock signal.
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USE MIDI DEVICES WITH BLACKBOX
If you prefer a more tactile input mode, you can use a MIDI device to play pads, keys and
sequences. MIDI can also be used to change the sound that is playing and to synchronize
clocks with other instruments. If you’d like to drive an external instrument with a
sequence in blackbox, you can connect it to the MIDI Outputs of blackbox.

Work with MIDI Inputs
Blackbox is designed to work with MIDI devices to offer a more tactile input mode and a
bigger keyboard. It can also use MIDI inputs to modulate pad and effects parameters.
Blackbox can also use MIDI clocks to synchronize with external equipment.
To start, plug your MIDI input device into either the Device USB jack or the MIDI In TRS
jack. If you are having trouble getting MIDI to work through the TRS jack, please read the
Mini TRS Audio Jacks for MIDI Connections Compatibility Guide at https://1010music.com/
stereo-minijacks-midi-connections-compatibility-guide. You may need to use the MIDI
adapter that came with blackbox. You can use MIDI inputs in a few different ways:
■ Trigger pad hits and trigger sequences
■ Play notes and use common MIDI modulation signals with a specific pad or pads
■ Play notes and use common MIDI modulation signals with the currently selected
pad
■ Use MIDI Continuous Controllers (CCs) to modulate various pad and effects
parameters
■ Use a MIDI Program Change to change the selected Preset
You can combine these different MIDI input modes to use more than one at a time, but
there are some rules about how they interact. First, we will talk about how to use each of
these MIDI play modes, and then we will discuss how they interact with each other.
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To Trigger Pad Hits and Sequences with a MIDI Device:
Blackbox has a MIDI Pads parameter that defines which MIDI channel can trigger pads
and sequences. By default, this value is set to Omni, which means that it will respond to
all MIDI channels. You can configure a specific channel by changing the value of the MIDI
Pads parameter on the Tools screen.
1.

Push TOOLS to display the Tools screen.

2.

Touch MIDI In at the bottom of the screen to go to that page of the Tools screen.

3.

Turn the knob next to the MIDI Pads parameter to select the MIDI channel that
you want to use to trigger pads and sequences. Set this to Omni to respond to all
MIDI input channels that have not been otherwise assigned.

4.

Connect your MIDI device to blackbox and configure it to use the MIDI channel
selected for the MIDI Pads channel.

5.

Play some notes on your MIDI device to trigger
pads. The table on the right shows the default
mapping of MIDI note numbers to the blackbox
pads. The range for pads is Note 36 (usually C2)
through Note 51 (usually D#3/Eb3). You may need
to shift your MIDI device up or down octaves to
reach these notes.

48

49

50

51
D#3

44

45

46

47

40

41

42

43

36
C2

37

38

39

Default Mapping of
MIDI Notes to
Blackbox Pads
Notes:
► You can customize the mapping of notes to pads on the MIDI page of
the Pads Parameters screen for each pad.
6.

Push PADS and you can watch the pads activate
on the Pads screen as you play notes on your MIDI
device.

7.

Play higher notes on your MIDI device to trigger
sequences. The table on the right shows how the
MIDI note numbers map to the blackbox
sequences. The range for triggering sequences is
Note 52 (usually E3) through Note 67 (usually G4).
You may need to shift your MIDI device up or
down octaves to reach these notes. Playing a MIDI
note for a given sequence will toggle its active
state on and off.
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64

65

66

67
G4

60

61

62

63

56

57

58

59

52
E3

53

54

55

Default Mapping of
MIDI Notes to
Blackbox Sequences
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8.

Push SEQS and you can watch the sequences start and stop on the Sequences
screen. A white rectangle will appear at the bottom of the sequence cell to show
that the sequence is queued up to play at the quantization break. This rectangle
is replaced with a blue progress bar when the sequence starts to play. The bar
will turn into a white rectangle again when the sequence is playing out after
deactivation.

To Play Notes and Use Common MIDI Modulation Signals with a Specific Pad or Pads:
You can also configure a specific pad to respond to MIDI notes by assigning a MIDI
channel to the pad on the pad’s parameters screen. How the pad responds will depend
on the Pad mode.
1.

Push PADS and select the pad you want to control with the MIDI device.

2.

Push INFO twice to see the Pad Parameter screen, and then touch MIDI at the
bottom of the screen to see the MIDI related parameters.

3.

Turn the knob next to MIDI In to assign a specific channel to this pad. Now your
MIDI device transmitting on this channel will play this pad. If the pad is in sample
(single), granular or clip mode, each MIDI note will play the pad pitch shifted in
the same way the Keys screen works. If the pad is a Slicer, each MIDI note will
play a slice of the file in the same way it works on the Keys screen. If the pad is
using multi-sample, the notes will trigger the appropriate sample based on root
note or sample mapping.
Notes:
► You can have more than one pad mapped to a specific MIDI channel. In
this case, blackbox will play all mapped pads when a note is received
on that channel.
► If you are using a modulation source other than MIDI CC for this pad,
then the corresponding MIDI Modulation signals received on this pad’s
MIDI In channel (e.g. MIDI Velocity) will be applied as configured for
this pad.

To Play Notes and Use MIDI Modulation Signals with the Currently Selected Pad:
This is a more global version of the procedure described in the previous section. The
difference is that here you are setting up a MIDI channel that is not pad specific.
Whichever pad is currently selected will respond to the MIDI channel specified as the
MIDI Keys channel. As with the MIDI Pads setting, you can select OMNI for the MIDI Keys
channel to have blackbox respond to all channels in this way. However, any channel that is
assigned to anything else is pulled from the pool of MIDI channels that blackbox
responds to in Omni mode.
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1.

Push TOOLS and then touch MIDI In to see the global MIDI input settings.

2.

Turn the knob next to MIDI Keys to select the MIDI Channel blackbox will use as
the global keys channel.

3.

Connect a MIDI Device to blackbox and set the device to use the channel
assigned to MIDI Keys.

4.

Go to the Pads screen and select a pad to play via MIDI. Play notes on the MIDI
device and you will see and hear the currently selected pad respond to the MIDI
notes. Select a different pad and play notes on the MIDI device and you will see
and hear the new pad respond.
Notes:
► If you have the same channel assigned to both a specific pad and to
the MIDI Keys setting, the assigned pad and the currently selected will
both respond to the MIDI input.

To Configure MIDI Modulation for a Parameter Using Named MIDI Sources:
1.
From the Pads screen, touch the pad you want to modulate.
2.

Push INFO until you see the MIDI parameter. Select a MIDI channel to be used to
modulate this pad.

3.

Push INFO until you see the parameter you want to modulate.

4.

Touch one of the three black boxes below the parameter to display the
Modulation Parameters screen.

5.

Use the control knobs to select a value for the Source parameter. This parameter
specifies which signal will be used to control this parameter. Available values are:
None –

no modulation source will be used.

VEL –

MIDI Velocity or the Velocity slider on the Pads screen. This is
note specific.

PTCH –

MIDI pitch bend signal

MODW –

MIDI Mod Wheel

MVOL –

MIDI Volume

MPAN –

MIDI Pan
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6.

Use the control knobs to select the Amount of modulation that will be applied.
This is used to increase or decrease the amount of impact the modulation will
have on this parameter.
Notes:
► The Modulation sources described in this section only impact the pad if
the modulation signal is received on the MIDI In channel for this pad.
► Modulation is only available for pad and effect parameters. Sequence
and section parameters cannot be modulated.

To Use MIDI Learn mode to Modulate a Parameter:
You can use a broad range of MIDI controls to modulate some of the pad parameters,
such as Filter and Pitch, and some of the FX parameters, such as Reverb Decay and Delay
Feedback. It can be challenging to determine which MIDI CC number is sent by any given
control on your MIDI device. To make it easier to use these MIDI CCs, blackbox has the
ability to learn which control you want to use for modulation for any given parameter.
1.

Connect a MIDI controller to blackbox.

2.

Navigate to the parameter page for the pad or FX parameter you want to
modulate.

3.

Touch one of the three black boxes below the parameter you want to modulate.
This brings up the Modulation Source screen.

4.

Touch Learn in the top right corner to enable MIDI CC learning mode.

5.

Move the MIDI control, such as a knob or slider, that you want to use with this
parameter. When blackbox has learned the mapping, the Learn button will turn
from blue to gray, and the Source parameter will change to MIDI CC.

6.

Turn the top right knob to adjust the Amount of modulation you want to allow
with this controller.

7.

Now play the pad and use the controller and you will hear the modulation. The
Modulation box associated with this mapping will be labeled CC.
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Notes:
► Different parameters work differently with MIDI CC inputs. For example,
for the Filter parameter, the values are bi-polar with 0 at the middle of
the range for the control by default. But with the Start parameter, the
values only move in one direction.
► You can map the same MIDI control to more than one parameter on
more than one pad or effect.
► MIDI CC controls use the on-screen parameter value as a starting point.
Blackbox then maps the range of the controller to values from the
starting point to the value of Starting Point +/- the Modulation Amount
parameter. For example, if the Filter parameter is set to 20%, and you
set the Modulation Amount to 15%, then the lowest value of the control
will map to 5% (20% - 15%), and the highest value of the control will map
to 35% (20% + 15%).
► MIDI CC mappings are recorded in the blackbox preset as a mapping to
a specific MIDI CC number on a specific MIDI Channel. If you swap out
MIDI controllers, and the new controller uses the same MIDI CC
number and channel, it will continue to modulate the assigned
parameter.
► The MIDI channel assigned to a pad does not need to match the MIDI
channel used for MIDI CC modulation.
► There is a maximum of 8 MIDI CC mappings per pad.
To Remove MIDI Modulation from a Parameter:
1.
Go to the parameter screen for that parameter.
2.

Touch the modulation box you want to clear.

3.

On the modulation parameters screen, turn the top left knob to set the Source
to none.

To Use MIDI Notes to Play Slices:
When a Slicer pad responds to MIDI Notes, it plays individual slices within the WAV file.
1.

Create a slicer pad and create 4 or more slices by either using the Scan feature or
manually creating the slices.

2.

Set the following values for the pad parameters:
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Parameter

Value

Explanation

Launch Mode

Trigger

This will cause the WAV
slice to play from
beginning to end when
a trigger is received.
Other values will work,
but let’s use this for the
example.

Loop Mode

Off

We will turn off looping
for this example.

Slice

3

This doesn’t impact how
the MIDI device or Keys
screen plays the slices.

MIDI

Choose a MIDI channel
not used by other pads
or the MIDI Pads or MIDI
Keys settings.

We want to see the
difference between the
default MIDI behavior
on the MIDI Keys and
MIDI Pads Channels and
using MIDI to trigger
slices, so we need to use
a separate channel.
MIDI notes received on
the channel you select
here will choose a slice
to play.

Slice Seq

None

We will not use the Slice
Sequencer in this
example.

PlayThru

OFF

For this example, we
want to stop sample
playback when we
reach the end of the
slice.

3.

Connect a MIDI device for input that uses the MIDI Channel you selected for the
MIDI parameter. Play MIDI note 36 (usually C2). You will hear that slice 1 is played.

4.

Play MIDI Note 39 and slice 4 will be played. MIDI Notes 36 and up are now
mapped to Slices 1 and up for playback.

The steps above show a simple example of using MIDI alone to trigger different slices
within one pad. You can use this with Loop Mode ON with Launch Modes of Gate or
Toggle to achieve different effects. You can also turn ON PlayThru for even more fun.
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Sharing of MIDI Input Channels
How do all of these MIDI Input channel assignments work together? Basically, they all
work together, with one big exception for Omni settings. Any channel that is assigned to
anything else will no longer be included in the list of channels responded to by a
parameter with the Omni setting. Here’s another way to think about it:
■ If the MIDI In channel is assigned on a pad, that pad will always respond to MIDI
notes received on that channel.
■ The currently active pad will always respond to MIDI notes on a given MIDI channel
if that channel has been specifically assigned as the MIDI Keys channel on the
TOOLS screen.
■ Pad hits and sequences will be triggered by notes on an incoming MIDI channel if
that channel has been specifically assigned as the MIDI Pads channel on the
TOOLS screen.
■ If the MIDI Keys parameter is set to Omni, and the incoming notes are on a MIDI
channel that has not been specifically assigned to anything else (a pad’s MIDI In, or
the MIDI Pads parameter), then the currently selected pad will respond to notes on
this channel.
■ If the MIDI Pads parameter is set to Omni, and the incoming notes are on a MIDI
channel that has not been specifically assigned to anything else (a pad’s MIDI In or
the MIDI Keys parameter), then the incoming notes will trigger pad hits and
sequences.
As a result, if you, for example, assign the same MIDI channel to both a specific pad’s MIDI
In parameter and to the MIDI Pads parameter on the TOOLS screen, notes on that
channel will be played by that specific pad and they will trigger pad hits and sequences.
This gives you lots of flexibility but could result in confusing results if you aren’t careful.
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Use MIDI Program Change to Open a Preset
Some MIDI controllers support a MIDI command to trigger a program change. Blackbox
can be configured to respond to MIDI program changes by loading a preset. Blackbox will
map the presets on the device in alphabetical order to program numbers. The first preset
on the device will be mapped to program 1. Keep in mind that when you change presets,
even with a program change, blackbox does not save your changes. So be sure to save
your preset if needed before initiating a program change.
Because of the potential for data loss, blackbox has a Tools parameter that allows you to
control whether or not the device responds to program change signals. By default, this is
set to off.
To Enable or Disable MIDI Program Changes:
1.
Push Tools.
2.

Touch the MIDI In tab at the bottom of the screen.

3.

Turn the knob next to the ProgChange parameter to select the value desired.

If you set ProgChange to ON, when you initiate a MIDI program change on any
connected MIDI channel, blackbox will change to the corresponding preset.
NOTE:
► Blackbox supports using MIDI Program Changes to access the first 128
presets. This limit is the result of how MIDI manages program banks.
► Blackbox does not pass through or send out MIDI Program Changes.

Work with MIDI Outputs
You can also use blackbox pads and sequences to send note events to drive other MIDI
instruments. Connect your blackbox to a MIDI device via the MIDI Out TRS jack. If you are
having trouble getting MIDI to work through the TRS jack, please read the Mini TRS Audio
Jacks for MIDI Connections Compatibility Guide on 1010music.com. You may need to use
the MIDI adapter that came with blackbox.
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To Send MIDI Notes from a Sequence to an External MIDI Device:
1.
Connect your MIDI device to the blackbox MIDI TRS Output jack and configure it
to use the desired MIDI channel.
2.

Create a sequence you want to use to drive the MIDI device. You can use any
WAV file in the pad used to play the sequence, and then mute the pad on the
Mix screen if you don’t want blackbox to generate sound for that pad.

3.

Push SEQS and select the sequence you want to use to drive the MIDI device.

4.

Push INFO until you see the parameters screen with the MIDI Out parameter.

5.

Set the MIDI Out parameter to the MIDI channel used by the MIDI device.

6.

Activate the sequence and push PLAY on blackbox. Blackbox will now send the
note events from the configured sequence to the MIDI device.

To Send MIDI Notes from a Pad to an External MIDI Device:
1.
Connect your MIDI device to the blackbox MIDI TRS Output jack and configure it
to use the desired MIDI channel.
2.

Configure a pad you want to use to drive the MIDI device. You can use any WAV
file in the pad, and then mute the pad on the Mix screen if you don’t want
blackbox to generate sound for that pad.

3.

Push PADS and select the pad you want to use to drive the MIDI device.

4.

Push INFO twice and then touch MIDI at the bottom of the screen to bring up
the MIDI parameters for that pad.

5.

Set the MIDI Out parameter to the MIDI channel used by the MIDI device that
will receive the signal.

6.

Trigger the pad on the blackbox by touching the pad, or playing it in a sequence.
Blackbox will now send the note events from the configured pad to the MIDI
device on the same MIDI channel.
NOTE:
► You can configure more than one sequence and pad to send MIDI out
on the same channel.
► Blackbox does not send out or pass through MIDI Program Change
messages.

Copyright 1010music LLC 2021

Page 95 of 106

Blackbox User Manual 1.7

SYNCHRONIZE PLAYBACK WITH A CLOCK
Blackbox can either run on its own internal clock or follow an external clock. It can also
provide a clock signal for other devices to follow.

Configure Blackbox to Follow an External Clock
There are a few different musical clock sources that you can use with blackbox:
Name

Description

Prior
ity

Clock In

Blackbox gets a Clock signal from an input to the
Clock In jack on the back of the case. You can tell
Blackbox what PPQ to expect on the TOOLS screen.

1

MIDI Input via
USB Device
port

When a MIDI signal is connected to the Device USB
jack on the back of the case, blackbox will follow
MIDI Start, Stop and Clock messages.

2

MIDI Input via
MIDI In TRS
port

When a MIDI signal is connected to the MIDI In TRS
jack on the back of the case, blackbox will follow
MIDI Start, Stop and Clock messages

2

Blackbox
Internal Clock

When no other clock input is provided, blackbox will
use its own internal clock. Set the BPM on the Song
screen to adjust the clock speed.

3

You can control whether blackbox responds to the USB Device MIDI input, the TRS MIDI
Input, or ignores MIDI clock on the TOOLS screen:
1.

Push TOOLS and then touch MIDI In at the bottom of the screen.

2.

Turn the knob next to the ClockSource parameter to select which MIDI clock
source you want to use. Select None to ignore the clock signal on both MIDI
inputs. Select All if you expect you will only use one clocked MIDI input at a time,
or if you just want the two clocks to fight it out.

Blackbox displays the current clock time in the top left corner of most screens in the
format <measure>: <beat>. If more than one clock input is available, the highest priority
clock signal (lowest priority number) will be used. Blackbox can adjust the timing of the
playback of a clip pad to synchronize it with a specified unit of musical clock time.
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NOTE:
► The Clock input can be in range between 1 and 24 pulses per quarter
(PPQs). Use the TOOLS page to adjust this.
► If MIDI and CLOCK inputs are both used, Blackbox will select the
highest priority clock based on the following order of priority: 1.) CLOCK
Input; 2.) MIDI Input; 3.) Internal Clock.
► See Work with a Clip Pad above for more information about
synchronizing clips.

Send the Blackbox Clock Signal to External Devices
Blackbox sends out a MIDI clock signal through the TRS MIDI output. If you are using the
TRS MIDI port, be sure to check TRS Mini-jack compatibility. See Pin Mapping for Mini TRS
Jack to MIDI 5 Pin DIN Connectors below for more information about compatibility.
Blackbox sends an analog pulse clock through the Clock Out port. You can configure the
PPQ sent out on the TOOLS screen.

Reset the Clock
You can use the following methods to reset the clock counter back to 1:1:
■ Press Play.
■ Stop the Clock input for a few seconds and then restart it.
■ Receive MIDI play and MIDI clock signal.

Copyright 1010music LLC 2021

Page 97 of 106

Blackbox User Manual 1.7

POWERING MIDI DEVICES
When you are using an external USB MIDI device with blackbox, you
will need to ensure you have an adequate power supply to drive both
blackbox and the MIDI device. Use the provided USB power cable
with one of the following to ensure adequate power:
■ The power supply provided to plug blackbox into a standard
power outlet
■ A power adapter that delivers at least 2 amps at 5 volts. Newer
iPad adapters will work.
The following power sources may not reliably provide sufficient
power to support blackbox plus a MIDI device:

Power Supply
With
International
Adapters

■ An iPhone adapter USB Power Adapter
■ A laptop or computer USB connection
■ Any adapter that supports under 2 amps at 5 volts
If you need to use one of these lower power sources for blackbox, you may be able to use
a separate power supply to power the MIDI device. If the power supplied is insufficient,
the MIDI controller may not power up and blackbox may have unreliable behavior.
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CREATE PRESET TEMPLATES FOR RE-USE
Preset template support was added in blackbox 1.2 in response to requests from some
users who like to set up their presets a certain way each time, and other users who want
to configure a preset in preparation for a live performance. Preset templates allow you to
configure the pad mode, output, MIDI settings, modulation and other settings before you
have associated a WAV file with the pad.
A preset template is simply a preset that has pads which have been configured but do
not have WAV files associated with them. Preset templates can also store all of the other
information a standard preset has: Sequences, Song Sections, FX, Mixer settings and
more.
To Configure a Pad without a WAV file:
1.
Select the pad you want to configure as a template on the PADS screen.
2.

Push INFO. If the pad is loaded with a WAV file, this will display the WAV screen.
In this case, touch the pad mode icon on the top left of the screen and then
select New Recording to remove the WAV file mapping. You will now see the
Load and Record screen.

3.

Push INFO again to see the Parameters screen for this pad.

4.

Choose the Pad Mode on the Main page of the Parameters screen.

5.

Use the buttons across the bottom of the screen to choose the desired page and
update the parameters as you normally would.

6.

Push PSET and then touch File and Save or Save As to save the changes to this
preset.

To Add a WAV file to a Template Pad:
1.
Select the pad you want to configure as a template on the PADS screen.
2.

Push INFO to display the Load and Record screen.

3.

Touch Load if you want to use an existing WAV file. Otherwise, begin recording a
new WAV as usual.
NOTE:
► Not all parameters are available before you add a WAV file to the Pad.
For example, you cannot add loop points to a sample mode pad
because blackbox does not know how long the file will be.
► You can use the SEQs, SONG, FX and MIX screens to configure other
elements as needed.
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REDUCE ALIASING WHEN PLAYING PADS CHROMATICALLY
Blackbox offers two choices for the interpolation algorithm used to play pads
Chromatically. The first algorithm is called Normal mode. In this mode, blackbox may
introduce some aliasing with some WAV files when pitch shifting notes to play sample,
multi-sample and granular pads chromatically. The second algorithm is the High Quality
(High Q) algorithm. This algorithm reduces the aliasing, but it requires more processing
power, leaving less room to do other things. By default, your pads will use the Normal
mode algorithm. You can configure a sample, multi-sample and granular pad to use the
High Quality algorithm when needed. Here’s how to configure this option:

1.

Open the parameter pages for the pad that is experiencing aliasing.

2.

Touch ADSR to select that page.

3.

At the top of the screen, to the right of the Exclusive grouping option, is the
interpolation algorithm option, which is set to Normal by default. Touch this to
display the options menu. Touch High Q to select the High Quality algorithm.

Note:
► The High Quality setting uses more processing power. This means you
may encounter drop outs or crackling sooner when this option is
selected. See Processor Management Tips below to learn techniques to
avoid drop outs and crackling.
► This option only applies when playing sample, multi-sample and
granular pads chromatically. If you are not playing the pad
chromatically, it’s best to leave it set to Normal.
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PROCESSOR MANAGEMENT TIPS
If you have experienced drop outs or crackling sounds with blackbox, you have probably
pushed the processor to its limits. Blackbox does not limit what you can do based on
anticipated processor load. We have tried to balance the design of the system to optimize
what you can do without over driving the processor while still giving you room to make
creative choices. That being said, here are some tips you can use to reduce your processor
load and the corresponding chance of encountering sound artifacts:
■ Configure your pads to run monophonic whenever possible. On most percussion
sounds, you won't hear the difference and this is an easy win.
■ Disable the reverb by making sure no pads have FX2 applied on the FX screen. This
is an expensive algorithm that can also be done off board. Keep in mind that the
reverb will continue to run for 60 seconds after you disable it, so you won't get the
benefit for a short while.
■ Use mono samples instead of stereo where appropriate. Stereo samples are twice
the work to load and play.
■ Use 48kHz samples when possible—especially for stuff played at unity pitch. This
gives the CPU less work to do.
■ Use the pad level filters sparingly.
■ Reduce the number of grains used for pads in granular mode.
■ For sample, multi-sample and granular pads, use Normal mode (at top of ADSR
screen). The High Q mode uses more processor cycles.
If you like crackly sounds, by all means do the opposite of what each of the tips above
suggest. Have fun!
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UPDATE FIRMWARE, AUDIO FILES AND PRESETS
You can update the blackbox firmware to get the latest features and other updates. The
firmware can be updated with the factory image, which includes the original presets, or
just the firmware itself. You can also choose individual presets to copy over to your
microSD Card.
Switch to a New MicroSD Card While Operating Blackbox
You can switch to a different microSD card while operating blackbox. Simply remove the
current card and insert the new one, then load a preset from the new card as usual. Just
make sure you save any changes before you remove the original card.
Backup Your Presets and WAV Files
Before you use a microSD card to update firmware, backup the files that are stored on the
microSD card:
Remove the microSD card from the front edge of blackbox and insert into your computer.
You may need to use a microSD adapter for your computer (not included).
Copy the files from the microSD card onto your computer.
To Install New Firmware:
Here are the steps required:
1.

Download the desired firmware onto your computer. You can find the latest
firmware images on the forum at https://forum.1010music.com. You must be a
registered user of the forum to access the download files. Forum registration is
free.

2.

Unpack the zip file. Some browsers do this automatically for you. Make sure the
name of the .bin file is exactly blackbox.bin. If you have a previous version on
your computer, sometimes the file gets renamed during download to create a
unique file name.

3.

Prepare a microSD card with the FAT32, MSDOS Fat, or ExFat format. The card
that comes with blackbox is formatted properly, but you may need to reformat a
card that came from somewhere else.

4.

If you want to replace the Presets with the factory image, copy the full contents
of the zip file onto a microSD card. If you do not want to overwrite your presets,
copy only the BLACKBOX.BIN file to the microSD card.

5.

Unplug blackbox.

6.

Place the updated microSD card in blackbox.
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7.

While plugging in blackbox, hold the BACK and INFO buttons. When you see the
words “Blackbox Installer” on the screen, you can let go of the buttons.

8.

When the upgrade finishes in about 15 seconds, the unit will restart with the
new software.

Reset a Blackbox Preset to Factory Settings
If you want to reset one or more of the blackbox presets to the original factory settings,
you can copy individual preset files onto your microSD card.
1.

Download the blackbox firmware onto your computer. You can find the available
firmware images on the forum at https://forum.1010music.com. You must be a
registered user of the forum to access the download files. Forum registration is
free.

2.

Unpack the zip file. Some browsers do this automatically for you.

3.

Find the *.xml file in the unpacked folder that has the same name as the preset
you want to restore. Copy the .xml file onto the microSD card to replace the file
on the card. Keep in mind that you will also need the WAV files that go with that
Preset and you may need to copy those over as well.

4.

Insert the microSD card into the MICRO SD slot of blackbox.

5.

Push the PSET button to display the Presets selection screen.

6.

Select any preset to load the updated presets.

Copyright 1010music LLC 2021

Page 103 of 106

Blackbox User Manual 1.7

TECHNICAL SPECS
On-Board Memory
Blackbox has 64MB of on-board RAM. However, this is a cache--not a hard limit to what
can be loaded at once because blackbox streams content from the microSD card in real
time..

Maximum Sample Length
Blackbox streams the longer samples from the microSD card, so the maximum length is
a function of the maximum file size for a sample. The maximum file size is 4GB, which
can be many hours depending on the sample rate and bit depth.
Blackbox caches smaller samples as needed.

Samples Supported
Blackbox supports stereo samples. It can record in stereo and has stereo outputs.
Blackbox supports samples in the WAV file format. It supports 1 or 2 channel files with 16,
24 or 32-bit resolution at any sample rate. 48kHz is the preferred sample rate. The
blackbox engine uses a 24-bit ADC and DAC.
WAV file names may use Alpha Numeric Characters (A-Z, 0-9) and some special
characters. The following characters are NOT allowed: double quotes, forward slash, back
slash, question mark, asterisk, less than and greater than symbols, the colon and the pipe
symbol (“ / \ ? * < > : |). File names must be less than 256 characters, including the
path name. Files that do not conform to these naming constraints will not be recognized
by blackbox.

Maximum Number of Voices Supported
Blackbox can support playback of up to 32 total voices across all pads at once.
Additionally, there is a limit for each pad, based on the pad mode. Blackbox supports 16note polyphony for pads in Sample and Multi-Sample Modes, 2-note polyphony in Clip
and Slicer Modes, and one note at a time in Granular mode. Nothing in blackbox will
prevent you from trying to play 16 voices on all 16 pads at the same time. However, the
CPU can be overloaded if you play too many notes at once while also using sequencing
and fx. You can reliably play 24 voices across all pads simultaneously. Beyond that, you
may encounter some sound quality issues like crackling. The exact breaking point
depends on whether effects are running, the CPU load and other factors.
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Pin Mapping for Mini TRS Jack to MIDI 5 Pin DIN Connectors
The musical instrument industry currently uses several different ways of mapping MIDI 5
Pin DIN signals to mini TRS jack connectors. The diagram below to the right shows the
numbering of the pins on a MIDI connector and the labels of the connection components
of a mini TRS jack. 1010music products are compatible with cables that use the following
mapping of MIDI signals between female MIDI connectors and mini TRS jacks:

Tip

Current Sink

Pin 5

Ring

Shield

Pin 2

Sleeve

MIDI Connector to Mini TRS Jack Signal
Mapping

1

3
4

5
Current
Sink

2
Shield

Current
Source
TIP
RING
SLEEVE

Pin 4

TIP

Current Source

RING

MIDI
Mini TRS
Connector

SLEEVE

MIDI Signal

5 Pin DIN and Mini TRS
Jack Connectors

For more information on the use of adapters, read the blog post on our website, Mini TRS
Jacks for MIDI Connections Compatibility Guide at:
https://1010music.com/stereo-minijacks-midi-connections-compatibility-guide
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STAY UP TO DATE
Demonstration Videos and Latest Documentation
You can find links to video demonstrations of blackbox on our website at https://
1010music.com/blackboxdocs. You can also look there for updated versions of this user
manual and the Quick Start Guide.

Connect with Other Blackbox Users
There is a very active community of users of 1010music products at forum.1010music.com.
If you have a question about blackbox that isn’t answered in this manual, this is your best
source for help. We actively monitor the wish list sub-forums for ideas for future versions
of our products. Forum registration is free. We hope to see you out there!

Contact Us
Are you loving blackbox? Have questions? You can contact us through our website at
https://1010music.com/contact-us.

Page 106 of 106

Copyright 1010music LLC 2021

